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Preface

Welcome to Release 6.0 of the Oracle Applications Desktop Integrator
Tutorial. This tutorial corresponds to Release 6.0 of Oracle Applications
Desktop Integrator.

This tutorial provides step–by–step instructions to help you quickly
and easily learn how to use the features of Applications Desktop
Integrator (ADI) for General Ledger and Oracle Assets. You should
only use ADI together with Oracle Applications.

ADI will work with any of the following Oracle databases:

• Oracle RDBMS version 7.1.6 or higher (7.1.5 for Open VMS).

ADI will work with any of the following Oracle Applications:

• Release 10.7 or higher.

ADI will work with any of the following General Ledger databases:

• Release 10.7 character mode, Smart Client, or NCA.

• Release 11.0.

ADI will work with any of the following Oracle Assets databases:

• Release 10.7 character mode, Smart Client, or NCA.

• Release 11.0.
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About This Tutorial 

This tutorial uses the Vision 11 demonstration database for examples
and exercises. Most of the instructions in this manual are also
applicable to earlier releases of the Vision demonstration database.
However, if you are using the Global demonstration database, please
refer to Oracle Applications Desktop Integrator Tutorial, Release 3.2.

Assumptions

This guide assumes you have a basic understanding of accounting,
your organization’s accounting process, and the flow of transactions
from your organization’s subledgers to the general ledger.

This guide also assumes you are familiar with Oracle General Ledger
and Oracle Assets. If you have never used Oracle General Ledger,
Oracle Assets, or the Oracle Applications Desktop Integrator, we
suggest you attend one or more of the related training classes available
through Oracle Education Services

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle provides powerful tools you can use to create, store, change,
retrieve and maintain information in an Oracle database. But if you use
Oracle tools like SQL*Plus to modify Oracle Applications data, you risk
destroying the integrity of your data and you lose the ability to audit
changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using an Oracle Applications window can update many tables at
once. But when you modify Oracle Applications data using anything
other than Oracle Applications windows, you may change a row in one
table without making corresponding changes in related tables. If your
tables are unsynchronized, you risk retrieving erroneous information
and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications windows to modify your data,
Oracle Applications automatically checks that your changes are valid.
Oracle Applications also keeps track of who changes information. But,
if you enter information into database tables using database tools, you
may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database
tools do not keep a record of changes.
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Consequently, we STRONGLY RECOMMEND that you never use
SQL*Plus, Oracle Data Browser, database triggers, or any other tool to
modify Oracle Applications tables, unless we tell you to do so in our
manuals.

Other Information Sources 

You can choose from many sources of information, including
documentation, training, and support services, to increase your
knowledge and understanding of Oracle Applications Desktop
Integrator, General Ledger, and Oracle Assets.

Related User’s Guides

The guides listed below provide detailed information about
configuring and using Oracle Applications Desktop Integrator, Oracle
General Ledger, and Oracle Assets. If you do not have the printed
version of these guides, you read them online from within Oracle
Applications, by using the Applications Documentation program icon
or the Help menu. You can also find them by choosing the Library
button from the Oracle Applications Desktop Integrator and online
help for General Ledger and Oracle Assets.

Oracle Applications Desktop Integrator User’s Guide

This guide describes how to use Applications Desktop Integrator’s
(ADI) Budget, Journal, Report, and Analysis Wizards for General
Ledger and Create Assets, Reconcile Physical Inventory, and Import
Assets for Oracle Assets. You can use these spreadsheet–based tools for
entering journals, entering and revising budgets, maintaining your
asset inventory, and creating financial reports. The guide also describes
how to use the Request Center to submit and monitor concurrent
requests, then download the report output for publishing to a
spreadsheet or a web page.

Oracle General Ledger User’s Guide

This guide is a complete source of information about General Ledger. It
contains overviews as well as task and reference information about the
General Ledger accounting cycle, journal entry, budgeting,
consolidation, financial reporting, multi–currency, encumbrance
accounting, standard reports and listing, and setting up General
Ledger.
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Oracle Assets User’s Guide

This guide provides information on using Oracle Assets to maintain
your assets, including information on Mass Additions, the Mass
Additions interface, Physical Inventory, and the Physical Inventory
interface.

Installation and System Administration

Oracle Applications Desktop Integrator Installation 
Guide, Release 6.0

This manual provides information you need to successfully install
Oracle Applications Desktop Integrator in your specific hardware and
operating system software environment.

Other Information

Training

Oracle Education offers a complete set of training courses to help you
and your staff master Oracle Applications. We can help you develop a
training plan that provides thorough training for both your project
team and your end users. We will work with you to organize courses
appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training
throughout the implementation process so that the right amount of
information is delivered to key people when they need it the most. You
can attend courses at any one of our many Educational Centers, or you
can arrange for our trainers to teach at your facility. In addition, we can
tailor standard courses or develop custom courses to meet your needs.

Support

From on–site support to central support, our team of experienced
professionals provides the help and information you need to keep
Oracle Order Entry, General Ledger, and Oracle Assets working for
you. This team includes your Technical Representative, Account
Manager, and Oracle’s large staff of consultants and support specialists
with expertise in your business area, managing an Oracle server, and
your hardware and software environment.
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About Oracle

Oracle Corporation develops and markets an integrated line of
software products for database management, applications
development, decision support, and office automation, as well as
Oracle Applications, an integrated suite of more than 45 software
modules for financial management, supply chain management,
manufacturing, project systems, human resources, and sales and
service management.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers, and personal digital assistants,
allowing organizations to integrate different computers, different
operating systems, different networks, and even different database
management systems, into a single, unified computing and information
resource.

Oracle is the world’s leading supplier of software for information
management, and the world’s second largest software company. Oracle
offers its database, tools, and applications products, along with related
consulting, education, and support services, in over 140 countries
around the world.

Thank You

Thank you for using Oracle General Ledger, Oracle Assets and this
user’s guide.

We value your comments and feedback. At the end of this manual is a
Reader’s Comment Form you can use to explain what you like or
dislike about Oracle Applications Desktop Integrator, Oracle General
Ledger, Oracle Assets or this user’s guide. Mail your comments to the
following address or call us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
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C H A P T E R
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1 – 1Getting Started

Getting Started

This chapter contains lessons that explain how to perform the following
tasks:

• How to start and signon to ADI

• Configure ADI for your personal use

• Use the ADI toolbar
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Overview

This tutorial describes the concepts and functionality of the
Applications Desktop Integrator (ADI) and the Request Center in a
hands–on format.

About ADI

ADI is a spreadsheet–based extension of Oracle Applications. It
provides full–cycle accounting within the comfort and familiarity of a
spreadsheet for General Ledger and Oracle Assets. By combining the
ease of use of a spreadsheet with the power of Oracle General Ledger
and Oracle Assets, ADI provides true desktop integration during every
phase of the accounting cycle.

You can create budgets, record transactions, and run financial
statements, standard reports, and listings, all without leaving your
spreadsheet. Create assets, reconcile physical inventory and import
asset data from other formats, also within a spreadsheet environment.
You can drill down on financial statement balances, revealing the
underlying numbers that make up the balances. You can print physical
inventory reports.

ADI includes the Diagnostic Wizard, Budget Wizard, Journal Wizard,
Report Wizard, Account Hierarchy Editor, Analysis Wizard, and Create
Assets, Record Physical Inventory, and Import Text File features. The
Request Center is an independent application that works with ADI to
submit, monitor, and publish reports for all Oracle Applications.

Diagnostic Wizard

The Diagnostic Wizard examines the Windows environment to ensure
the stability of ADI, as well as all Windows software. It provides
specific feedback with instructions for corrective action when it finds
issues such as incorrect settings for ADI, file versions, registries, or
configuration. It can even apply the latest OLE patches. With this
handy ADI utility, you can quickly troubleshoot and correct installation
problems.
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Budget Wizard

The Budget Wizard provides a spreadsheet–based budget entry screen.
It facilitates simple data entry and modeling in a disconnected
environment.

Use the Budget Wizard to automatically build a budget spreadsheet
based on the budgets and budget organizations you set up within
General Ledger. You can download existing budget balances from
General Ledger or create a new budget. You can enter your new budget
balances manually, use budget rules, or use formulas and models. You
can dynamically add new budget accounts, while validating the new
account against security rules. You can then automatically graph your
budgets, and even compare budget and actual balances using a variety
of graph styles. Afterward, you can save a budget spreadsheet on your
PC and work on it at any time. When you are satisfied with your
budget, you can automatically upload your new budget balances into
General Ledger.

Journal Wizard

With the Journal Wizard, you can design and automatically generate
journal entry worksheets which utilize popular spreadsheet data entry
techniques. You enter journal entries directly in a spreadsheet so that
you can take advantage of spreadsheet data entry shortcuts, such as
copying and pasting or dragging and dropping ranges of cells, or even
using formulas to calculate journal line amounts.

Applications Desktop Integrator validates your data against the
accounts and reference information you defined in General Ledger. It
also enforces segment security and cross validation rules. You can then
automatically upload your journals to General Ledger. Before
uploading, however, you can save and distribute your journal
worksheets for approval.

Report Wizard

The Report Wizard provides a spreadsheet–based interface to Oracle
General Ledger’s financial reporting engine, the Financial Statement
Generator (FSG). The Report Wizard seamlessly supports report
definitions for all user levels. Novice users can define simple reports
entirely within a spreadsheet, intermediate users can use a combination
of spreadsheets and assistance windows, and advanced users can use
configurable property sheets which allow for even quicker data entry
than in the spreadsheet alone.
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Most importantly, the spreadsheet interface allows users to manage the
reporting process within the comfort and familiarity of a spreadsheet,
while still taking advantage of the FSG’s reusable and interchangeable
report objects, server–based processing for high performance, and
report scheduling for efficient use of system resources.

Analysis Wizard

The Analysis Wizard combines dynamic report drilldown with OLAP
analysis capabilities. You can drill directly from FSG spreadsheet
reports into Oracle General Ledger without having to predefine
drilldown paths. You can select individual amounts from spreadsheet
reports and drill directly into the underlying financial details. You can
also change Period or Amount Type during drilldown, to analyze
another period or create a trend report without generating a new
report.

The Analysis Wizard presents you with the complete range of accounts
that support a particular reported amount, including summary
accounts, detail accounts, and journals. You can tailor your view of the
financial information by using drill options and drop down menus, so
that you can display account descriptions and filter out unneeded
accounts. You can also instantly pivot financial information online to
work through what–if and what–happened scenarios.

Account Hierarchy Editor

The Account Hierarchy Editor allows you to create, maintain, and
manipulate General Ledger account structures from a single location,
using an intuitive and easy to learn drag and drop interface. Use the
Account Hierarchy Editor to keep your account structure consistent
with changes in your organization. You can create new parent and child
values or modify dependencies in an existing hierarchy, copy your
current hierarchy to make changes without affecting the original, or
create a new independent hierarchy to model a pending reorganization.

The Account Hierarchy Editor and the Report Wizard facilitate time
based reporting with date effective hierarchies.

Create Assets

The Create Assets feature provides a spreadsheet–based interface to
simplify asset creation. Use the Create Assets feature to automatically
build personalized asset entry spreadsheets based on the information
required by your organization’s specific implementation of Oracle
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Assets. You can enter your asset data manually, use the list of values,
and take advantage of Excel’s data entry shortcuts. You can also map
data files from legacy systems or third party payables applications into
the asset worksheet. When you are satisfied with the worksheet, the
Create Assets feature automatically uploads the data into Oracle
Assets.

Reconcile Physical Inventory

The Record Physical Inventory feature provides a spreadsheet–based
interface to simplify the physical inventory process. Use the Record
Physical Inventory feature to automatically build personalized physical
inventory spreadsheets based on the information required by your
organization’s specific implementation of Oracle Assets. You can enter
your physical inventory data manually, use the list of values, and take
advantage of Excel’s data entry shortcuts. You can also map files
created from scanned barcode data into the physical inventory
worksheet. When you are satisfied with the worksheet, the Record
Physical Inventory feature automatically uploads the data into Oracle
Assets

Import Text File

The Import Text File feature allows you to import data from legacy
systems, third party payables applications, barcode scanners, or any
other flat data file sources, to your worksheet. Using the Import Text
File feature, you can map fields in your source file to fields in your
worksheet. Once you have created the map using the Import Text File
feature, you can save it and apply it to future conversions.

Request Center

The Request Center is an enterprise report management tool for
centralized report submission, monitoring, and publishing. Not only
can you submit both predefined and ad hoc FSG’s, but you can also
produce any standard report or listing from any Oracle Application.

The Request Center monitors concurrent requests and automatically
notifies you when your reports, journal uploads, or budget uploads are
complete. You can then view your concurrent request log or report
using your web browser, a spreadsheet, or any word processor or
editor. You can even categorize your concurrent requests by adding
specific requests to a Hot List for immediate access in the future. You
can also schedule your request at a later date and time.
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After defining your FSG reports, you can submit them directly from the
spreadsheet or the desktop environment. Although you submit reports
from your PC, reports run on the server for maximum processing
efficiency. In addition, you can submit any Oracle Application report or
listing as permitted by your responsibility.

Using the Request Center, you can publish your reports to:

• A web page

• A spreadsheet

• A plain text format

• A databasae

Web Publishing

With web publishing, you can eliminate printing reports for manual
distribution by creating output in HTML format and publishing your
HTML reports directly to a web site. You can even choose to
automatically apply report themes to web output.

Each time you run the report, you also have the option of automatically
updating the web page. When report output is expanded over a chart
of account segment, such as cost center, the Request Center optionally
creates links in your web page to each department’s report so that you
can easily maintain the information. By linking a spreadsheet version of
your report to the web page, you can easily distribute analyses
throughout an organization. Analysts can download the spreadsheet
version as needed.

Database HTML Publishing

The Request Center can publish reports directly into the database. You
can then access these reports using a standard web browser from three
home pages: the Web Reporting Kiosk, the Oracle Business Intelligence
System (BIS) home page, or the Self–Service Web Applications home
page.

Database HTML publishing offers all the benefits of web publishing
and eliminates the need for hard–copy report distribution by creating
output in HTML format. The key difference between web and database
publishing is where the reports are stored. Web publishing stores
reports on a web server or a local machine. Published database HTML
reports are stored in the database. Reports stored in the database let
create report libraries that chronicle historical information. You can also
manage report security for database published reports with a number
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of security models. Reports published to a web server have more
limited security options.

Spreadsheet Publishing

The Request Center also automatically copies report output back to the
spreadsheet while applying custom formatting, such as colors, fonts,
and a corporate logo. You can automatically apply report themes to
output.

Plain Text

The Request Center can also automatically copy report output to an
ASCII file without formatting.
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Before Starting the Tutorial

This section describes requirements for this tutorial and the tasks that
you must perform before taking the tutorial.

Tutorial Requirements

 Before using this tutorial, make sure of the following:

• Applications Desktop Integrator version 6.0 or later is installed
on your PC.

• The VISION demo database is installed on your server.

Note:  The Vision database is shipped with Oracle Applications
Release 10.7 and later. If you are using an earlier version of
Oracle General Ledger, use the Global tutorial instead.

• Your PC is configured to connect to the database and view
reports from the server.

• Either Microsoft Excel 7 (Win 95) or Excel 8 (Win 97), 32 bit only,
is installed on your PC.

• Either Netscape Navigator or Microsoft Internet Explorer is
installed on your PC.

Note:  Oracle Applications Release 10.7 and higher is required
to use Oracle Assets with ADI. Physical Inventory is only
available with Oracle Applications Release 11 and higher. If
you cannot use Create Assets, Reconcile Inventory, and Import
Text File features, see your system administrator.

Setting Up the Tutorial

Running the Diagnostic Wizard

To facilitate trouble–free use of ADI, you first run the diagnostic
wizard.

� To run the Diagnostic Wizard:

1. Locate the Diagnostic Wizard icon on your desktop and double
click on it.
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The Diagnostic Wizard performs a system check. The results of the
test appear.

2. Click on each button to get more details about the specific test and
its result.

If the Diagnostic Wizard finds problems, a red indicator appears to
flag areas that need to be fixed. Click on the appropriate bar to get
more information about the problem and suggestions on how to fix
it.

3. When you complete the diagnostic test, click Exit to close the
Diagnostic Wizard.

Setting Up the Tip Wizard

The Tip Wizard allows you to interact with an animated character that
will appear and explain what actions can be taken for each ADI
function. Imagine a talking robot, genie, parrot, or sorcerer, that walks
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into your computer and guides you through ADI. You can choose from
four characters and reduce the learning curve as you proceed through
the ADI Tutorial.

See: Applications Desktop Integrator Installation Guide for more
information on installing the Tip Wizard.

Setting Up the Web Publishing Folder

When you use ADI’s web publishing feature, you publish your web
output to a folder called, web server.

1. On your PC, create a folder called web server.

Setting Options

Applications Desktop Integrator is highly configurable, with an
extensive set of options for customizing the look and feel of budget,
journal, report, asset, and physical inventory worksheets. ADI saves
the options you select, so you only need to set them one time.

� To start ADI:

1. Choose the ADI icon on your desktop or choose the Windows Start
button and select Programs > Oracle ADI > Applications Desktop
Integrator.

The ADI toolbar will appear on your desktop.

2. Choose the Signon button.

The Oracle Applications Signon window appears.
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3. Enter the username and password that you use to sign on to Oracle
Applications (for example, OPERATIONS/WELCOME).

4. Select the database you want to use.

5. For this tutorial, you should use the GENERAL LEDGER, VISION
OPERATIONS USA responsibility.

If you check Use Last Responsibility, ADI chooses the responsibility
you used during your previous ADI session. Otherwise, ADI
prompts you to choose a responsibility from the same list of
responsibilities that you use to access Oracle Applications (for
example, GENERAL LEDGER, VISION OPERATIONS USA).

6.  Choose OK, the button pictured as a checkmark, to sign on.

After ADI connects to the database, your toolbar includes
additional buttons. The Request Center starts, but it is minimized.

You are now ready to set options that indicate how you want to work
with ADI.

General Options

You can customize the ADI user interface by making selections from
the General Options.

� To set general options:

1. Choose the Options button in the ADI toolbar, and select General
Options.

2. Select the Worksheet Colors tab to choose color options for your
worksheet.

For this option... Make this entry...

Field Text White
Field Background Blue
Context Text Black
Context Background Yellow
Data Entry Area White
Sheet Background Gray

3. Select the Theme Defaults side–tab to choose default formatting
options for your report.

For this option... Make this entry...

Report Title Arial 16, bold, no italic, bright yellow text,
forest green background, no border
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Report Heading Arial 10, bold, no italic, forest green text,
white background, no border

Column Headings Arial 10, bold, italic, black text,
bright yellow background, border

Line Items Arial 10, bold, no italic, white text,
forest green background, border

Amounts Arial 10, no bold, no italic, black text,
white background, border

Logo appslogo.bmp or a bitmap image of your
corporate logo

Include Border Checked
Include Shadow Checked
Align Left
With Heading

4. Select the Settings tab.

For this option... Make this entry...

Start ADI When Opening Workbook Checked
Start Request Center at Signon Checked
Show Upload Success Indicator Checked
Zero Pad Account Values Checked
Enable Hot Keys Checked
Always On Top Checked

5. Select the Installation tab Options to setup ADI for your
installation.

Run Custom Macros Checked
Perform Self–Check at Startup Checked
Play Sounds for Events Checked
Integrator Directory C:\Oraclehome\GLDI90
Integrator Program Filename GLDI9032.exe
Applications Program Filename AIAP45.exe

Ledger Options

You set Ledger options to customize the interface and user defaults for
the Budget Wizard, Journal Wizard, Report Wizard, and Analysis
Wizard.

� To set Ledger Options:

1. Choose the Options button in the ADI toolbar, and select Ledger
Options.

2. Select the Budget tab to indicate the appearance of your budget
worksheets and graphs.
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For this option... Make this entry...

Decimal Places Database
Minimum Width of Value Columns 12
Update Budget Status Checked
Graph Style 3D Column
Generate Axes Checked
Include Budgets and Actuals Checked

3. Select the Journal tab to indicate the appearance of your journal
worksheets.

For this option... Make this entry...

Apply Format to Fields Arial 10, bold, no italic
Apply Format to Hints Arial   8, no bold, no italic
Default Number of Rows 10
Minimum Width of Value Columns 12
Field Name Width 5
Context Width 3
Field Value Width 3

4. Select the Report Definition side–tab to indicate the appearance of
your report definition worksheets.

For this option... Make this entry...

Rows 10
Columns 5
Column Width 15
Line Item Width 24
Format 99,999,999
Factor Units
Account Assignments Indicator Royal blue
Calculations Indicator Royal blue
Exceptions Indicator Red
Make Copy Default No
Enforcement Level Do Not Prompt

5. Select the Report Analysis tab to indicate the drill and
environment options.

6. Set the options as follows:

For this option... Make this entry...

Display Segment Values Individually
Minimum Amount Width 15
Show Totals Checked
Double–Click Drill Enabled Checked
Hide Windows When Navigating Checked
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Maximum Active Drills 5

Request Center Options

The Request Center contains many options for customizing request
notification and report publishing. You can also set these options from
within the Request Center.

� To set Request Center options:

1. Choose the Options button in the ADI toolbar, and select Request
Center Options.

For this option... Make this entry...

Update Every 30 seconds
Query Last 100 Programs
Flash Notification 5 times
Display All Programs
Play Sound When Request Completes Checked (if your PC can play sounds)
Normal wow.wav
Error hornwhst.wav
Output Viewer notepad.exe
Print Settings MS Sans Serif, 8, no bold, no italic,

page border

Language Options

ADI is now fully National Language Support (NLS) compliant and
translatable. The English version was available in October of 1998, with
other languages following during the last calendar quarter of 1998.
Please call support at 1–800–223–1711 to determine if your preferred
language is available.

You can change the language displayed on your ADI forms and online
help forms through the Set Language options selection. This NLS
functionality is compatible with native Windows 95 and Windows NT
operating systems and defaults to the regional settings for the current
user.

� To set Language options:

1. Choose the Options button in the ADI toolbar, and select Language
Options.

For this option... Make this entry...

Language Default (English US), or Specific
Font MS Sans Serif, 10, Bold, or Specific
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Help Default (English US), or Specific

Exiting ADI and the Request Center

� To exit ADI and the Request Center:

1. Choose the Exit button on the ADI toolbar.

ADI prompts you for confirmation about exiting.

2. Choose the Yes button.

3. Choose the Exit button in the Request Center toolbar to exit the
Request Center.

ADI prompts you for confirmation about exiting the Request
Center.

4. Choose the Yes button.



1 – 16 Oracle Applications Desktop Integrator Tutorial

Starting ADI

In this section, you will learn how to start Applications Desktop
Integrator.

Note:  You start ADI by double–clicking the ADI icon, you do
not navigate to ADI from within Release 10SC of Oracle
Applications.

� To start ADI:

1. Choose the ADI icon on your desktop   OR

Choose the Windows Start button > Programs > Oracle ADI >
Applications Desktop Integrator.

The Applications Desktop Integrator toolbar appears.

2. Choose the Signon button.

The Oracle Applications Signon window appears.

3. Select the database that you want to use.

4. Enter the user name and password that you want to use to sign on
to Oracle Applications (for example, OPERATIONS/WELCOME).

Note:  If you are using ADI on Citrix WinFrame, you must
connect to the Citrix server as a unique user from others who
are signed on to a ADI session on Citrix. This prevents conflicts
between ADI sessions.

5. For this tutorial, you should use the GENERAL LEDGER, VISION
OPERATIONS USA responsibility.

To use the same responsibility that you used in a previous ADI
session, choose the Use Last Responsibility check box. Otherwise,
ADI prompts you to choose a responsibility from the same list of
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responsibilities that you use to access Oracle Applications (for
example, GENERAL LEDGER, VISION OPERATIONS USA).

Note:  If you are learning how to use the Create Assets or
Record Physical Inventory features, select the Assets, Vision
Operations (USA) responsibility instead.

6. Choose OK, the button pictured as a checkmark, to sign on.

Your toolbar expands to include additional buttons.

7. Slowly move your cursor across the toolbar. Pause at each button
to view a descriptive pop–up window.

ADI Toolbar 

You can access ADI’s functions from the toolbar buttons or from the system’s hot keys:

Signon:  Enter your username and password, and choose a respon-
sibility.

Hot key:  [Ctrl–Shift–S].

Change Responsibility:  Choose a different responsibility once
you’ve signed on to your Application database.

Hot key:  [Ctrl–Shift–R].
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General Ledger Poplist:  Choose General Ledger to access the fol-
lowing ADI wizards and General Ledger functionality.

Enter Budgets:  Create budget worksheets, refresh values in the cur-
rent budget worksheet, or edit the budget criteria for the current
budget worksheet.

Hot key:  [Ctrl–Shift–B].

Enter Journals:  Create a worksheet for entering journals.
Hot key:  [Ctrl–Shift–T].

Define Report:  Define FSG reports or download existing report
definitions.

Hot key:  [Ctrl–Shift–D].

Analyze Report:  Perform multidimensional analysis with report
drilldown, completely within Excel.

Account Hierarchy Editor:  Start the Account Hierarchy Editor,
which you can use to manage your account structure. The button
will not appear unless your responsibility allows you to modify ac-
count structures.

List of Values:  Choose from a list of valid values for a particular
item, such as currency or journal category.

Hot key:  [Ctrl–Shift–L].

Upload to Interface:  Upload your budget values or journal entries
to the General Ledger interface tables. Provides the option to auto-
matically start the Submit Process function (see below).

Hot key:  [Ctrl–Shift–U].

Submit Process:  Start any of these processes:
• Import budget values or journal entries from the interface tables

to General Ledger. Your process can also be submitted automati-
cally from the Upload to Interface function (See above).

• Delete journal import data from the General Ledger Interface
• Submit standard, standard (variable) or financial statement re-

ports and publish on the web, in a spreadsheet or text file.
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Insert Budget Account:  Insert a new account row into a budget
worksheet.

Apply Budget Rule:  Use budget rules, such as Repeat per Cell or
Divide Evenly by Row, to update your budgets.

Hot key:  [Ctrl–Shift–Z].

Add Budget Note:  Append notes to an entire budget, an account,
or individual amounts in a budget worksheet.

Hot key:  [Ctrl–Shift–N].

Create Graph:  View your budget balances in graph form.
Hot key:  [Ctrl–Shift–G].

Assets Poplist:  Choose Assets to work with Oracle Assets function-
ality.

Create Assets:  Create asset data in an Excel spreadsheet.

Record Physical Inventory:  Enter physical inventory data in an
Excel spreadsheet.

Import Text File:  Import a text file containing asset or physical in-
ventory data, which you format in an Excel spreadsheet and upload
into Oracle Assets.

List of Values:  Choose from a list of valid values for a particular
item, such as location or category.

Hot key:  [Ctrl–Shift–L].
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Upload to Interface:  Upload your asset and physical inventory
data to the Oracle Assets interface tables. Provides the option to au-
tomatically start the Submit Process function (see below).

Hot key:  [Ctrl–Shift–U].

Submit Process:  Start any of these processes:
• Post Mass Additions from the Mass Additions interface table to

Oracle Assets or Start Physical Inventory Comparison Process.
Your process can also be submitted automatically from the
Upload to Interface function (See above).

Applications Poplist:  Choose applications to access the Request
Center, Oracle Applications, or Start Excel.

Request Center:  Submit, monitor, and publish reports.
Hot key:  [Ctrl–Shift–W].

Oracle Applications:  Start Oracle Applications if it is installed on
your PC. When you select this button, you will be asked to select an
applications database. If you use the same database as for your ADI
session, you will not have to enter your username and password in
Oracle Applications.

Hot key:  [Ctrl–Shift–A].

Start Excel:  Start Microsoft Excel.
Hot key:  [Ctrl–Shift–E].
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ADI Options Poplist:  Use to access general options for ADI, Gen-
eral Ledger, Request Center, and Language options. Also use to ac-
cess sign on and ADI release information.

Hot key:  [Ctrl–Shift–O].

Toolbar Options:  Use to add, delete or arrange icons on the ADI
toolbar.

General Options:  Define general settings for your ADI interface
environment. Set worksheet colors and default formatting for your
report themes.

Ledger Options:  Define default settings for Budget Wizard, Journal
Wizard, Report Wizard, and Analysis Wizard.

Request Center Options:  Set defaults for Request Center queries,
and sound notifications. Define print settings.

Hot key:  [Ctrl–Shift–W].

Language Options:  Change the language ADI uses in windows,
menus and tool tips. Set fonts and font characteristics.

Information:  Check details for the set of books you are using and
your current signon information. Check ID numbers related to your
signon authority and the set of books you are accessing.

About ADI:  ADI Release information.
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Tip Wizard:  Set Tip Wizard Options, display the greeting, or dis-
able the Tip Wizard.

Help:  Access the online help features of ADI.
Hot key:  [Ctrl–Shift–H].

Minimize:  Minimize the toolbar to an icon on the Windows desk-
top.

Hot key:  [Ctrl–Shift–M].

Exit:  Close and exit ADI.
Hot key:  [Ctrl–Shift–X].
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Creating Budgets and
Journal Worksheets

This chapter contains lessons that explain how to perform the following
tasks:

• Create budgets using the Budget Wizard

• Create and upload journals using the Journal Wizard



2 – 2 Oracle Applications Desktop Integrator Tutorial

Creating Budgets With the Budget Wizard

In this section, you learn how to create budgets using the Budget
Wizard.

About the Budget Wizard

The Budget Wizard provides a spreadsheet–based budget entry screen
which facilitates simple data entry and modeling in a disconnected
environment.

Use the Budget Wizard to:

• Automatically build a budget spreadsheet based on the budgets
and budget organizations you set up within Oracle General
Ledger.

• Download existing budget balances from Oracle General Ledger
or enter data for a new budget entirely within your budget
worksheet.

• Enter your new budget balances manually, use budget rules, or
use formulas and models.

• Insert new accounts into your budget worksheet. You can then
automatically graph your budgets, and even compare budget
and actual balances using a variety of graph styles.

• Save a budget spreadsheet on your PC and work on it at any
time.

• Automatically upload your new budget balances into Oracle
General Ledger when you are satisfied with them.
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Budget Wizard Features and Benefits

Because the Budget Wizard does
this... You can...

Automatically builds budget
worksheets, based on the budget
elements you define in Oracle
General Ledger

Eliminate double maintenance by
combining a commonly–used
budgeting tool (spreadsheets)
with the budget elements you de-
fine in Oracle General Ledger.

Provides a flexfield pop–up win-
dow to assist entering and vali-
dating new budget accounts

Use the spreadsheet to conve-
niently update your budget orga-
nization.

Enforces segment value security
in budget worksheets

Protects sensitive data from un-
authorized access.

Sets display characteristics (such
as account descriptions and sort
order), limits accounts to down-
load, and filters budget informa-
tion that meets criteria your spe-
cified

Customize your view of the bud-
get data, enabling ease of mainte-
nance and reporting.

Inserts budget accounts in the
budget worksheet, while also ap-
plying segment value security
rules

Add budget accounts directly
from the worksheet, while vali-
dating the new account against
security rules and the account
ranges applied to your budgets.

Provides predefined budget
rules, such as spreading an
amount across a range of cells, as
well as spreadsheet–based for-
mulas and models

Automatically calculate your
budget amounts using any type
of formula.

Creates graphs of your budgets
and actuals using a variety of
graphing styles, such as bar
graphs, line graphs, and even
3–D area graphs

Have a clear picture of how your
budget and actual amounts
compare for a wide range of ac-
counts.

Provides budget notes to add de-
scriptions to accounts and
amounts in your budget

Justify or explain your budget
without external documentation
or paperwork.
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Building a Budget Worksheet

To build a budget worksheet, you specify the budget elements that you
want to budget:

• Budget. Since you can create multiple budget versions, you need
to specify the budget version and period range you want to use.
You define a budget using the Define Budgets window in Oracle
General Ledger.

• Organization. With budget organizations, you control which
users can budget to certain accounts. For example, you may
want cost center managers to enter only budget amounts for
their own cost centers. You can define a budget organization for
each cost center, and protect each organization with a different
password; managers can only budget to their own cost center.
You define budget organizations using the Define Budget
Organization window in Oracle General Ledger.

• Currency. When you assign accounts to a budget organization,
you specify the currency that you use to enter budget amounts
for these accounts.

The Budget Wizard creates your budget worksheet by downloading all
of the accounts that are assigned to your budget organization, along
with any existing budget amounts.

� To build your budget worksheet:

1. Choose General Ledger from the ADI toolbar and select Enter
Budgets from the List of Values.

The Create Budget Worksheet window appears.

2. In this field... Select... 
Organization Operations
Budget ADJUSTED 1997
Currency USD
Period Range  JAN–97 to DEC–97

In the Status region of the window, notice the value in the Number
of Accounts field. It indicates the number of accounts that are
assigned to the Operations budget organization with a currency of
USD.

You can limit the accounts that you want to download to your
budget worksheet.
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3. Choose the Limit Accounts button.

The Select Account Segment Ranges window appears

4. Use the list of values to select 5110 as the Account Low.

5. Type 5300 in the Account High field, and choose OK.

Notice that the value in the Number of Accounts field was
reduced, as you requested.
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6. Choose the Set Characteristics button.

The Set Characteristics window appears. On this window, you can
re–sequence and sort the segments and segment values in your
budget worksheet. You can also choose the account descriptions
you want to display.

7. Next you define the account structure that you want to use for
budgeting.

The account structure is Company – Department – Account – Sub
Account – Product. For budgeting purposes, however, you may be
most interested in the natural account. Click on the Account
segment in the Display Order column and drag it to the top of the
column.

8. Click on the corresponding item in the Sort Order column and
move it in the same way.

9. Change the Sort Direction to Descending for the Department
segment.

10. Because you want to include descriptions for the account segment,
check the Show Desc box for that segment.

11. Choose OK.

The Budget Wizard creates the budget worksheet with the natural
account segment values in the leftmost column, sorted in ascending
order. It sorts the accounts by Department in descending order. It
displays the descriptions for the Account segment.

12. Choose OK in the Create Budget Worksheet window to build your
budget worksheet.
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Viewing and Entering Budget Amounts

The Budget Wizard creates a budget worksheet that looks similar to the
one in the following example. Note that the amounts and accounts in
your worksheet may differ from the accounts and amounts in the
following example.

Your accounts appear in the gray region on the left of the budget
worksheet, and the associated budget amounts appear in the white
region on the right.

� To view and enter budget amounts:

1. View a larger region of the budget amount information by choosing
the View Context and View Desc buttons at the top of the
worksheet.

The context and account information disappears so that you can
view more budget amounts.

2. Redisplay the context and account description by clicking on the
View Content and View Desc buttons again.

3. You can change budget amounts by typing over the existing
amounts. You can also use more sophisticated budgeting tools,
including budget rules, formulas, and models.
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Type 400,000 in the cell corresponding to JAN–97 for the first
account.

4. Type 500,000 in the cell corresponding to JAN–97 for the second
account.

5. Highlight a 4x4 section of budget amounts, and choose the Apply
Budget Rules button on the ADI toolbar.

The Apply Budget Rules window appears.

6. From the Rule field, choose Repeat per Cell.

7. In the Amount field, type 300,000 .

8. Choose OK.

The Budget Wizard entered 300,000 as the budget amount for all of
the cells in the selected region.

It also set the Upload flag for the appropriate accounts.

Inserting Budget Accounts

With the Budget Wizard, you can insert accounts into your budget
worksheet. ADI verifies that the account is:

• not a duplicate on your spreadsheet

• a valid account

• part of the budget organization account range.
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� To insert budget accounts:

1. Move the cursor on the row above where you want to insert a
budget account.

2. Choose on the Insert Budget Account button.

The Select Account Segment Value window appears.

3. Select the following flexfield combination: 01.110.5400.0000.000.

4. Choose OK.

The account is now inserted into the worksheet.

5. Enter 30,000 for Jan–97 for the inserted account.

Filter Budget Values

You can filter budget rows to select values, amounts, or descriptions.
Rows that do not meet the criteria you specify are hidden so that you
can focus on the information you want to work with.

� To filter budget values:

1. Choose the View Filter button.

A filter button appears beside all the column headings of the
budget.

2. Click on the Account column, and select 5110.
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The Budget Wizard only displays rows for Account 5110 Cost of
Sales.

3. Further filter your budget by clicking on the JAN–97 column.

4. Select Custom as your filtering criteria.

The Custom AutoFilter window appears.

5. Choose greater than (>) 400,000, and choose OK.

The Budget Wizard only displays rows for Account 5110 that have
JAN–97 amounts greater than 400,000.

6. Choose the Reset Filter button to redisplay all the budget rows you
downloaded.

7. Turn off the Filter arrows by choosing the View Filter button.

Upload Budget Amounts

Now that you have updated budget amounts for accounts (by
manually typing the amounts and by using a budget rule), you are
ready to upload your budget amounts to Oracle General Ledger.
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� To upload budget amounts to Oracle General Ledger:

1. Choose General Ledger from the ADI toolbar and select Upload to
Interface from the List of Values.

2. The Upload Budgets to Interface window appears.

3. Check the following options:

• Flagged Rows for Rows to Upload

• Replace for Upload Mode

• Prompt Before Deletion of Existing Rows

• Start Budget Import.

Leave the default of None for Pre–Validation.

4. Choose OK to start the upload.

The Budget Wizard uploads your flagged rows to the Budget
Interface table. It then starts a budget upload concurrent process,
which updates your budget amounts in Oracle General Ledger. The
Budget Wizard displays a message which looks like the following
sample:
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This message indicates that the budget upload concurrent process
has begun. The process runs on the server so you can continue
using the Budget Wizard while the process completes.

5. Restore the Request Center by choosing Applications from the ADI
toolbar and selecting Request Center from the List of Values.

Your concurrent request appears on the Pending tab, along with its
status information.

When the request finishes, the Request Center moves your request
to the Completed tab. It notifies you that the process is complete by
blinking at the bottom of your screen and playing a sound file (if
your PC can play sound files).

6. Minimize the Request Center.

7. Scroll your worksheet to the right to view the Messages column.

A green success indicator appears in each row that you uploaded.

Note:  If multiple users upload budget amounts for the same
account simultaneously, the Budget Wizard asks if you want to
overwrite the other budget amounts or leave the other budget
amounts in the interface table. You will see a message similar to
the following message:
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Depending on your response, the following occurs:

If you choose... The Budget Wizard...
Yes Overwrites the existing row and prompts

 you if it encounters another duplicate row.
Yes to All Overwrites the existing row and all other

duplicate rows.
Keep Existing Leaves the earlier budget amount in the

 interface table.

Graphing Budget Amounts

� To graph budget amounts:

1. Select a 6x6 region of budget amounts on your budget worksheet.

2. Choose General Ledger from the ADI toolbar and select Create
Graph from the List of Values.

The Budget Wizard creates a new worksheet in your workbook
which contains a 3D column graph of your budget amounts.
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3. Change the orientation of the graph by moving the rotation slider
at the top–left corner of the worksheet.

Alternatively, to rotate the graph real–time, first click anywhere on
the graph to select it, then click on any corner of the graph and
rotate.

4. Try different graph styles using the graphing toolbar.

Verifying the Budget Upload

After the Budget Upload process completes on the server, you can
refresh your budget worksheet to see your updated amounts.

� To verify the budget upload:

1. Return to your budget worksheet by clicking the Budget 1 tab at
the bottom of your workbook.

2. Highlight a region of budget amounts, and choose Clear All from
the Edit menu.

3. Choose General Ledger from the ADI toolbar and select Enter
Budgets from the List of Values. Check Refresh Budget Values.

4. Choose OK.

The Budget Wizard downloads the budget balances from the
database, just as it did when you first created your budget
worksheet. However, you modified some budget amounts since
you initially created the worksheet. The Budget Wizard downloads
the new amounts.
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Creating Models (Optional)

Just as you can use budget rules to automatically calculate budget
amounts, you can also use formulas and models.

In this section, you will learn how to create a model and incorporate it
into your budget worksheet.

Skip this lesson if you do not want to create a model at this time.

� To create a model:

1. From the Insert menu, choose to insert a worksheet.

A blank worksheet, titled Sheet 3, appears.

2. Highlight roughly a 10x10 section of cells in the blank worksheet

3. For effect, format the highlighted section. Choose Cells from the
Format menu and use the Border tab to add a border.

4. Use the Patterns tab to color the highlighted section, and choose
OK.

5. Type the word MODEL in the middle of the section.

6. Type the word Result below your model, and type 400,000 in the
next cell.

You will link that result to one of the cells in your budget
worksheet.
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7. Return to your budget worksheet. Type an equal sign (=) in one of
the amount cells.

8. Immediately return to the model worksheet, click on the 400,000,
and press Return.

9. Return to the budget worksheet, and notice that 400,000 now
appears in place of the equal sign. Your cursor appears in the cell
below the 400,000.

The link is dynamic, so any changes to the model are reflected in
the budget worksheet.

10. Return to the model worksheet, replace the 400,000 with 500,000.
Return to the budget worksheet and notice that the 400,000 was
automatically updated to 500,000.

When you upload your budgets to Oracle General Ledger, you
upload the amounts that appear in the sheet. Therefore, you can
work on your budgets for as long as needed, refining your models
as you go. Any time you upload your budget amounts, you always
upload the up–to–date results.
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Adding Notes to Amounts and Accounts

You can use budget notes to provide justifications, or explanations, for
the amounts in your budget worksheet.

After uploading budgets to Oracle General Ledger, you can attach your
budget worksheet to the Enter Budget Amounts window by using the
Oracle Applications attachments feature.

� To create a budget note for an amount and an account:

1. Select an amount cell in your budget worksheet, choose General
Ledger from the ADI toolbar and select Budget Notes from the List
of Values.

The Add Budget Note window appears.

2. Choose to add a budget note to an amount by checking Amount.

The Cell Note window appears. Choose OK.

3. Type a note, such as Approved by <your initials> on <date>, and
choose OK.

4. Press Tab to move the cursor to the next cell.

A red dot appears in the cell where you entered your note,
indicating that a budget note is linked to the cell.

5. Repeat the previous steps, but choose to add a budget note to an
account instead of an amount.

In this case, your budget note applies to all of the budget amounts
for the account, not just a single amount.
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Using Attachments (Optional)

This lesson illustrates how to add your budget worksheet as an OLE
attachment to the Enter Budget Amounts window.

Skip this lesson if you do not want to use attachments at this point.

� To use attachments:

1. Save your spreadsheet, and minimize Excel.

2. Start Oracle General Ledger if it is not already running.

3. Navigate to the Enter Budgets window in Oracle General Ledger
(standard path: Budgets Enter Amounts).

4. Choose the same budget organization, budget, currency, and
period range that you used with the Budget Wizard.

Organization: Operations
Budget: ADJUSTED 1997
Currency: USD
Period Range: JAN–97 to DEC–97

5. Click in the Account field.

The Find Accounts window appears.

6. Type 5110 in the Account Low field, and 5300 in the Account High
field.

7. Choose OK to retrieve the accounts in this range that are assigned
to your budget organization.

These are the same accounts that are included in your budget
worksheet, but they are in a different order in this window.

8. Click in the Budget Organization field, and choose the Attachments
button.

9. To attach the spreadsheet you saved earlier, enter Budget Amounts
for the category, Budget Justification for the description, and OLE
Object for the data type.

10. Right–click in the white region at the bottom of the screen, and
choose Insert Object.
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The Insert Object window appears.

11. Choose Create from File, and then use the Browse button to locate
the spreadsheet that you saved.

12.  Do not check Link.

13.  Choose OK.

A section of your worksheet appears on the Attachments window.
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14. Right–click and choose Worksheet Object Open to open the
spreadsheet.

The notes are included with the worksheet, so anyone who queries
this budget can view the budget justifications.

15. Close the Attachments window and the Enter Budget Amounts
window.

16. Minimize Oracle General Ledger.

17. Restore Excel.
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Creating and Uploading Journals With the Journal Wizard

In this section, you learn how to enter and upload journals using the
Journal Wizard.

About the Journal Wizard

With the Journal Wizard, you can design and automatically generate
journal entry worksheets, which utilize popular spreadsheet data entry
techniques. You enter journal entries directly in a spreadsheet, so you
can take advantage of data entry shortcuts, such as copying and
pasting or dragging and dropping ranges of cells, or even using
formulas to calculate journal line amounts.

ADI validates your data against the accounts and reference information
that you defined in Oracle General Ledger. It also enforces segment
security and cross validation rules. You can then automatically upload
your journals to Oracle General Ledger. Before uploading, however,
you can save and distribute your journal worksheets for approval.

Journal Wizard Features and Benefits

Because the Journal Wizard
does this... You can...

Automatically builds spread-
sheet–based journal entry work-
sheets based on the journal type

Work with a data entry screen
that is tailored to your data entry
requirements. It includes only the
information that you want to en-
ter.

Enables quick journal entry by
copying and pasting journal
lines, then making incremental
modifications

Maximize productivity by de-
creasing the necessary keystrokes
to enter data.

Define journal templates that you
can modify and upload repeated-
ly

You can enter recurring journal
entries by saving a journal work-
sheet, then uploading it whenev-
er appropriate, such as every
month.
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You can...
Because the Journal Wizard
does this...

Performs full validation of ac-
counts with enforcement of seg-
ment security and cross valida-
tion rules, as well as other refer-
ence fields.

Build efficiency because you get
real time feedback on errors to
correct them on the spot.

Loads journals into Oracle Gen-
eral Ledger through the General
Ledger open interface.

Leverage existing General Ledger
functionality for importing jour-
nal entries from subledgers, and
provide auditability through
execution reports.

Creating a Journal Worksheet

To build a journal worksheet, first specify the type of journals you want
to enter. Choose from functional currency actual, foreign currency
actual, budget, or encumbrance.

You also choose whether you want to enter a single journal entry or
multiple journal entries. You choose single if all of your journal lines
share common header information, such as accounting period,
category, and currency. If your journal lines do not share this
information, choose multiple journal entries so you can enter different
header information for each journal line.

Based on your choices, the Journal Wizard automatically includes the
journal information in your journal worksheet. You can always add
more journal information.

� To create a journal worksheet:

1. Choose General Ledger form the ADI toolbar and select Enter
Journals from the List of Values.

2. Choose the Functional Actuals journal type, and choose to enter a
single journal entry.

3. Choose the Layout Editor button in the Create Journals window.

The Define Worksheet Layout window appears. This window
shows whether journal information is optional or required. It also
lists optional journal information you can choose to include in your
journal worksheet.
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You can re–sequence both the required and optional information.
You can choose to view a sample journal worksheet, which
displays both the required journal information and any optional
information you chose to include.

4. Choose one of the fields in the Required Fields list. Use the arrow
buttons to re–sequence the fields. Scroll downward in the header
region of the sample layout to see your new ordering.

5. Choose to include the Journal Name in the optional fields list by
checking it.

The journal name is now included in the sample layout.

6. Choose the Lines tab and add the Description field.

It is now included in the sample layout.

7. Choose OK in the Define Worksheet Layout Window, and then
choose OK in the Create Journal Worksheet window.
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The Journal Wizard creates a journal worksheet that reflects your
choices.

Your journal worksheet should look similar to the following:

Note the following:

• The journal header region lists fields in the sequence that you
chose.

• The journal lines region includes a Description field because you
chose to include it.

• The category defaults to Adjustment because the profile option
Journals: Default Category is set to Adjustment.

• The source defaults to Spreadsheet because that is the default
source for journal worksheets.

• The currency defaults to USD because that is the functional
currency for this set of books.
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Entering Journals

� To enter a journal:

1. Type the journal header information.

2. Enter JAN–98 as the accounting date.

The accounting date appears in the format that you chose for your
spreadsheet.

3. The Journal Wizard provides full online validation. For example,
Adjustment is the default category, but you can change this to any
valid category.

Double–click on the Adjustment value. The Select Category
window appears. Double–click on any other category.

4. For the journal name, type <your initials> JE #1.

5. Double–click on any segment field (Co, Dept, Acct, etc.) in the first
journal line.

The Select Account Segment Values window appears, where you
can type each segment value or choose from lists of valid values.

6. ADI reflects default segment values as defined in Oracle General
Ledger. Leave the default value of 01 for Company.

7. Choose the Department field. From the list of values, choose
Department 130.

These values are validated real–time against the values defined in
Oracle General Ledger. Notice that the Journal Wizard displays the
description.
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8. Type 5800 in the Account value field.

Even without using lists of values, the Journal Wizard provides
real–time validation of your account values. The Journal Wizard
supplies the description, Salaries, which corresponds to account
5800.

9. Leave the default values for Sub–Account and Product.

10. Choose OK to close the Select Account Segment Values window.

The Journal Wizard displays the values you chose in your Journal
Worksheet.

11. Enter a debit of 2000 for this account.

You can define shorthand aliases to represent commonly–used
accounts. Shorthand aliases save data entry time because you can
enter an easy–to–remember name instead of a combination of
segment values.

12. Double–click on any segment field in the second journal line.

 The Select Account Segment Values window appears.

13. Choose Employee Exp. from the Account Alias field at the top of
the window. Choose OK.

The Journal Wizard enters the corresponding account values in the
journal worksheet.

14. Enter a debit of 1000 for this journal line.

15. Of course, you can type accounts directly into the journal
worksheet instead of using the additional windows.

For the third journal line, type the combination
01.110.7740.1100.000, pressing Tab after each segment to enter the
segment value in the appropriate worksheet column.

16. Enter a credit of 3000.

Uploading Journal Entries

Now that you’ve entered a balanced journal entry, you are ready to
upload it to Oracle General Ledger.

� To upload journal entries:

1. Choose the Upload to Interface button in the ADI toolbar.
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The Upload Journals to Interface window appears.

2. For the Rows to Upload option, choose Flagged Rows.

3. For the Pre–Validation option, choose Full.

Full Pre–Validation validates all journal data, including journal
fields for which a list of values is available, including
cross–validation rules.

Note: The Validate on Server profile option in Oracle Applications
must be set to Yes. Partial pre–validation checks everything except
cross–validation rules. If you select None, cross–validation is
handled by the journal import program in Oracle General Ledger.

4. For the If Upload Errors are Encountered option, choose Do Not
Upload Any Rows.

5. Check the Start Journal Import option.

6. Choose OK to start the upload.

The Journal Wizard uploads your flagged rows to the interface
table, and it then starts a journal import concurrent process, which
runs on the server.

The concurrent process creates journal entries in Oracle General
Ledger, based on the journal information in the interface table. The
Journal Wizard displays a message that looks similar to the
following:
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The message informs you that the journal import concurrent
process has started. It runs in the background, so you can continue
using the Journal Wizard while the process completes. The Request
Center notifies you when the process completes by blinking at the
bottom of your screen, and by playing sound if your PC can play
sound files.

7. Notice that the Messages column displays a green success indicator
in each row that you uploaded. To enable this feature, go to the
ADI Toolbar and choose the Options icon. Select General Options.
Choose the Settings tab in the window that appears. Be sure the
Show Upload Success check box is checked.

During upload, the Journal Wizard validates your accounts and
reference fields, such as source and category. If you entered invalid
values for any of these fields, the Journal Wizard displays an error
message when you upload. For example, if you entered an invalid
category, you see the following:

In this case, you can use the list of values to choose a valid
category, and then upload again.

Using Data Entry Shortcuts

One of ADI’s greatest strengths is the data–entry shortcuts it supports,
since it uses a spreadsheet for data entry.
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You will now learn how easy it is to copy journal lines, then quickly
modify the copied lines instead of retyping them.

� To use data entry shortcuts:

1. Highlight the account combination in the third journal line of the
journal worksheet that you just uploaded.

2. Drag downward to highlight the next three rows.

3. From the Edit menu, choose Fill Down.

The account segment values are copied down into the next three
rows.

4. Replace the Department in the first new row with 120, the second
new row with 130, and the third new row with 140.

You just entered three journal lines with only a few keystrokes.
These same techniques will help you to quickly create much larger
journal entries.



2 – 30 Oracle Applications Desktop Integrator Tutorial

Verifying the Journal Upload

After the Request Center notifies you that the journal import process is
complete, you can verify that your journal entry was created in Oracle
General Ledger.

� To verify the journal upload:

1. Start Oracle General Ledger if it is not already running.

2. Go to the Enter Journals window (standard path: Journals Enter).

3. You must ensure that the Enter Journals folder does not have an
embedded query that may restrict the journal entries that are
uploaded.

Choose Reset Query from the Folder menu.

4. In the Find Journals window, choose the More button to display
additional fields.

5. In the Journal field, type %<your initials>%.

6. In the Date Created From field, use the list of values to select the
current date.

7. Choose the Find button to retrieve your journal.

8. Choose the Review Journal button in the Enter Journals folder to
view the journal entry you uploaded from your spreadsheet. You
can then modify the journal, or post the journal to update account
balances.

9. Before proceeding to the Report Wizard section, return to Excel,
close the Enter Journals window, and minimize Oracle General
Ledger.
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Creating Reports

This chapter contains lessons that explain how to perform the following
tasks:

• Define reports using the Report Wizard

• Submit, monitor, and publish reports using the Request Center
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Defining Reports With the Report Wizard

In this section, you learn how to create financial reports with the Report
Wizard. You will create a six–month rolling income statement by
simply specifying a few attributes and choosing accounts that you want
to include in the report.

About Report Wizard

The Report Wizard provides a spreadsheet–based interface to Oracle
General Ledger’s financial reporting engine, the Financial Statement
Generator (FSG).

Novice users can define simple reports entirely within a spreadsheet.
Intermediate users can use a combination of spreadsheets and
assistance windows. Advanced users can use configurable property
sheets which allow for even quicker data entry than in the spreadsheet
alone.

Within the Report Wizard, you can use the Content Set Generator to
automatically create complex content sets to achieve time–based
reporting. Content sets override the row set definition of an existing
report and replace the row set account assignments and/or display
options. With Content Set Generator you can easily create content sets
that represent your hierarchy at a point in time. If your structure
changes, you can use these content sets to compare results against the
current and prior hierarchies.
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Report Wizard Definition Features and Benefits

Because the Report Wizard does
this... You can...

Provides an intuitive user inter-
face to Oracle General Ledger’s
Financial Statement Generator
and powerful server–based pro-
cessing

Maximize your efficiency.

The wizard–driven Content Set
Generator automatically creates
complex content sets

Quickly create point–in–time
snapshots each time you reorga-
nize your corporate hierarchy.
You can produce comparative re-
ports based on different hierar-
chies to determine the best rollup
for your organization. Over time,
you can create a collection of
these date–effective hierarchies,
which are encapsulated as con-
tent sets and then submitted at
report runtime.

The Content Set Generator dis-
plays a graphical representation
of the hierarchies it encapsulates.

Immediately visualize how re-
ports will roll up. You can also
check the hierarchy to ensure it is
exactly what you want for your
report.

Includes a wizard driven inter-
face allowing users to quickly
create new financial statements

The Report Wizard increases pro-
ductivity by decreasing the num-
ber of keystrokes required to de-
fine a report.

Provides several different meth-
ods for defining reports includ-
ing entering report attributes di-
rectly within a spreadsheet, using
assistance windows, or using
configurable property sheets

The Report Wizard seamlessly
supports report definitions for all
user levels. Novice users can de-
fine simple reports entirely with-
in a spreadsheet. Intermediate
users can use a combination of
spreadsheets and assistance win-
dows. Advanced users can use
configurable property sheets. The
additional assistance windows
allow for faster data entry than in
the spreadsheet alone.
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You can...
Because the Report Wizard does
this...

Expands upon spreadsheet menu
choices including right mouse
button support to quickly invoke
a special Report Wizard menu

Decrease training activities be-
cause The Report Wizard builds
upon the already familiar user in-
terface of Excel.

Includes a Report Navigator Easily visualize and navigate
through reports. You can get a
clear understanding of the struc-
ture of even the most complex re-
ports. You can quickly locate any
attribute of any report compo-
nent.

Creating a Report Definition Worksheet

In this lesson, you create a six–month rolling income statement.

� To create a report definition worksheet:

1. Choose General Ledger from the ADI toolbar and select Define
Report from the List of Values.

2. In the Definitions field, check Define Report, and choose the Next
button.
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3. Choose to use a blank report for your report definition, and choose
the Next button.

4. For the report name, type <your initials> Income Statement.

5. Since this is a 6–month rolling report, increase the number of
columns to 6.

6. Choose the Next button.

Notice that the format mask is 99,999,999 and the factor is units.
These choices tell the Report Wizard to allow enough room in each
column for numbers up to 99,999,999 and to report in base currency
units instead of thousands or millions.

7. Choose to define a trend report. Choose the Next button.

8. For Select Balance Type, choose the Actual option, and select
PTD–Actual from the drop–down list.

9. For the Trend Options, choose to roll forward and increment
monthly.

These choices tell the Report Wizard to report on PTD–Actual
balances in all 6 columns, to roll through a 6–month period from
the leftmost column to the rightmost, and to roll from the earliest
period to the latest period.

10. Choose Finish to build a report definition worksheet.

You just completed half of the report definition process, as the
attributes you specified are all that is necessary to define the
columns of your report.

To complete your report definition, you just need to define your
line items.
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The Report Wizard Toolbar

When you create a new report or open an existing one, Report Wizard
displays the Reports Toolbar.

Slowly drag your cursor across the toolbar to show the brief
description for each button.

Report Objects:  Display all report and object properties. These include
Report, Row, Column, Content, and Row Order properties that are ac-
tive for the currently displayed report.

Row Properties:  Display the Row Properties window. From here you
can see all of the properties associated with each of your row defini-
tions. You can also choose to display additional windows showing Row
Account Assignments and Row Calculations.

Column Properties:  Display the Column Properties window. From
here you can see all of the properties associated with each of your col-
umn definitions. You can also choose to display additional windows
showing Column Account Assignments, Column Calculations, and
Column Exceptions.

Insert/Delete Row Object:  Insert a new line item (row) into your row
set, or, for an existing line item, insert account assignments. You can
also delete a line item or its account assignments.

Insert/Delete Column Object:  Insert a new column or column heading
row into your report worksheet. You can also delete a column or col-
umn heading row.

Move Column Left:  Move a column to the left.
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Move Column Right:  Move a column to the right.

Save Report to Database:  Save your report back to General Ledger. If
you want to save your report to a diskette for later editing, use the File
Save function in your spreadsheet.

Refresh Report From Database:  Restore your report from the General
Ledger database to your currently open report worksheet.

Hide Tools:  Close the Reports Toolbar.

The Report Definition Worksheet

The following diagram illustrates the different regions of a report
definition worksheet. Note that your report definition worksheet will
not include everything in the diagram because your worksheet
represents a new report, while the following diagram represents a
complete report.
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The report indicators indicate whether accounts, calculations, or
exceptions are entered for each row and column. Numbers indicate
how many ranges of accounts are entered for each row, while the letter
C indicates a calculation, and the letter E indicates an exception
definition.

Using the Report Definition Worksheet

The Report Wizard automatically enters the attributes you specified,
such as balance type and factor, in hidden regions in the worksheet.

You use the plus sign (+) buttons along the top and left sides of the
report worksheet to display hidden regions.

When you display a hidden region, the plus sign (+) button changes to
a minus sign (–). By expanding and collapsing hidden regions, you can
enter report attributes directly in your spreadsheet, yet you can always
see how your report will look when you run it.

� To use the Report Definition worksheet:

1. Choose the plus sign (+) button to the left of the report title (the
topmost + button).

The hidden region expands to display the name of the report, row
set, and column set. The Report Wizard automatically groups your
rows into a row set and your columns into a column set. Row sets
and column sets can be reused in new reports.

2. Choose the minus sign (–) button to hide the row set and column
set names.

3. Choose the plus sign (+) button to the left of the column heading
(the second + button from the top).

4. Notice that the Report Wizard automatically entered the column
attributes based on the choices you made when you built the report
definition worksheet.

For example, the Report Wizard enters PTD–Actual as the amount
type for every column. It also enters the period offset for each
column, from 0 to 5, because you specified that this is a trend
report and that periods should roll from the earliest to the latest.

5. Notice the column headings in the report. FSG automatically
replaces &POI with the period–of–interest when you run the
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report. Thus, you can run the report every month, and your
headings always display the correct periods.

6. To hide the column set attributes, choose the minus sign (–) button
next to the column set .

Entering Line Items

You are already half finished producing this report. Your columns
are defined. Now, you are ready to finish defining your report by
entering line items

� To enter line items:

1. Select the first line item and type REVENUE over Line 1. This row
will be a heading row.

2. Select the second line item, and type five spaces and the word,
Product.

3. Select the third line item, and type five spaces and the word,
Service.

4. Select the fourth line item, and type five spaces and the word,
Training.

5. Select the fifth line item, and type five spaces and the word,
Expense.

Normally, you would continue making entries for each row in the
report. For the purposes of this lesson, you can stop now and begin
entering accounts for the rows you defined.

6. Right–click on the Product line item.

A Report Wizard menu appears. You can access many Report
Wizard functions through this menu.



3 – 10 Oracle Applications Desktop Integrator Tutorial

7. From the menu, choose Show Attributes, and then Line Item.

This menu choice has the same effect as pressing the plus sign (+)
button that corresponds to the line item.

8. Examine the row attributes.

Use the row name to refer to this row in calculations. The display
field indicates if this row should be displayed. For example, you
would not display the row if you were only using it for calculation
purposes. The level of detail allows you to specify who should be
able to view certain rows.

9. Right–click on the Product line item, and choose Insert Object and
then Line Account Assignment.

An Account Assignments region appears in your spreadsheet.

You can type account assignments directly in this region, or use a
list of values to enter accounts.

10. Double–click anywhere in the Account Assignments region to open
the Select Account Segment Ranges window.
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11. Select the Account Low cell to open a list of values for the Account
field.

12. Select account 4110, and choose OK to close the list of values.

Notice that 4110 is listed as both the low and high account value.
Therefore, the Product line item displays the total balance for
account 4110 (Hardware), across all companies, departments,
sub–accounts and products.

13. Choose OK to close the Select Account Segment Ranges window.

Your range appears in your report definition worksheet. The
number 1 appears in the Report Indicators area to signify that one
range of accounts was entered for the Product line item.
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14. Right–click and choose Summary Report Layout to hide the row
attributes. You can once again see how the report will appear when
you run it.

15. Right–click on the Service line item, and choose Insert Object and
then Line Account Assignment.

16. Double–click anywhere in the Account Assignments region to open
the Select Account Segment Ranges window.

17. Type 4120 in the Account Low cell and 4130 in the Account High
cell (without opening the list of values).

18. Choose OK to close the Select Account Segment Ranges window.

The Report Wizard enters your range in the worksheet.

19. Right–click and choose Summary Report Layout to hide the row
attributes.

20. Right–click on the Training line item, and choose Insert Object and
then Line Account Assignment.

21. Type 4140 directly in the Account Low cell, and press Tab.

Notice that 4140 is automatically copied over to the Account High.
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22. Right–click and choose Detail Report Layout. You can now see all
hidden regions.

23. Scroll downward to see the account range that is assigned to each
row.

24. Save your report by pressing the Save button in the Report Wizard
toolbar.

You just created an income statement. It is as simple as specifying a
few attributes, such as balance type and period offset, and then
entering accounts.

Next, learn how to download an existing report to view a complete
report definition.

Downloading an Existing Report

You can define reports from scratch, from existing report objects such
as row sets and column sets, or by downloading an existing report.

In the last lesson, you defined a report from scratch. In this lesson, you
will download an existing report.

� To download an existing report:

1. Choose General Ledger from the ADI toolbar and select Define
Report from the List of Values.

2. Choose to define a report, and choose Next.

3. Choose to load an existing report, and choose Next.

4. Type Summary Income Statement, and choose OK.

5. Choose Finish.

A message appears asking if you want to make a copy of the report
or use the original report.

6. Choose to use the original.

The Report Wizard downloads the report to your spreadsheet.
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7. Expand and collapse the different regions to show the various
attributes.

Using Advanced Features to Define Reports

Report worksheets include the most common report attributes used in
defining reports. A novice user can define reports completely within
the report definition worksheet, while a more advanced user can take
advantage of report definition aids such as the Report Objects window.

You can use the Report Objects window to include different report
objects and attributes as you define financial reports.

In this lesson, you also learn how to use the Report Navigator to obtain
instant access to any report object within a report.

� To use the Report Objects window:

1. Choose the Report Objects button in the Report Wizard toolbar.

The Report Objects window appears. It includes a tab for each
report object.

2. Next, you will flip through the tabs to see the attributes for each
report object. Start by choosing the Report tab.
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The Report tab indicates the report objects, or components, that are
assigned to your report. You use the Report tab to specify attributes
that affect your entire report, such as the currency and level of
detail.

You also use the Report tab to specify whether you want your
report to produce standard output (which is useful when reviewing
a report using a word processor or text editor) or spreadsheet
output (which is useful when downloading a report to a
spreadsheet or an HTML file). Notice that the output option is set
to Spreadsheet because you will run this report and download the
output to the web and to Excel.

3. Choose the Row tab.

The Row tab includes all of your line items and associated
attributes. You use the Row tab to enter accounts for each row, just
as you already did in the report worksheet. You can also define
calculations such as subtotals.

4. Choose the Column tab.

The Column tab includes all of your column definitions. You use
the Column tab to assign accounts to your columns; however, it is
more common to enter accounts for your line items.

You can also enter calculations for your columns. You can even
enter exception conditions to automatically flag amounts if certain
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conditions are met. For example, you can have the Report Wizard
display an asterisk (*) if your prior year numbers are greater than
your current year numbers for any revenue line item.

5. Choose the Content tab.

The Content tab includes information for defining a content set for
your report. You use a content set to automatically generate
multiple versions of a report. For example, you can use a content
set to break your income statement out by department. When you
run the report, the Report Wizard produces a separate income
statement for each department.

Note that the features in the Content tab are identical to the Define
Content Set features in Oracle General Ledger. Do not confuse it
with the Content Set Generator, which uses the parent–child
hierarchy structure in the General Ledger to automatically create
content sets.

6. Choose the Row Order tab.

The Row Order tab includes information for you to order rows in
your report. Use a row order to control the order and display of
line items in your report. For example, you can choose to expand
your revenue line items to display a separate row for each product.
You can then use a row order to sort the different products and
display both the product value and description.

� To use the Report Navigator:

1. If the Report Navigator is not already open, press the Display
Report Navigator button in the Report Objects window.

The Report Navigator appears. It provides instant access to any
report object, such as rows and columns.
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2. Choose the minus sign (–) beside Summary Income Statement at
the top of the window.

The navigator collapses to show only the topmost level of the
report hierarchy, the report itself.

3. Choose the plus sign (+) to expand one level and show the row set,
column set, and content set that make up the report.

4. Choose the plus sign (+) beside the row set and column set to see
the rows and columns that are assigned to them.

5. Choose various rows and columns, and the content set, to see that
the Report Objects window is synchronized with the navigator.

You have now seen how the Report Navigator provides instant
access to any report object within a report.

6. Close the Report Navigator and Report Objects window.
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Generating Content Sets

You can generate complex content sets for advanced time–based
reporting. Content sets work by overriding the row set definition of an
existing report and replacing the row set account assignments and/or
display options.

You can create point–in–time snapshots of your organizational
structure, in the form of content sets, and then reuse them in
subsequent periods for comparative analysis. As a result, you can run
reports that compare similar items even if your organizational structure
changes.

Another advantage of using Content Set Generator, instead of simply
defining the content set in the Report Components window, is that the
Content Set Generator uses parent values that you define in the General
Ledger to create a content set based on the hierarchical structure. This
feature saves a significant amount of time for structures with complex
and dynamic hierarchies.

In this lesson, you learn how to generate a content set that prints
separate reports for each department.

� To generate a content set:

1. Choose General Ledger from the ADI toolbar and select Define
Report.

2. Choose Generate Content Set, and choose Next.

The Generate Content Set window appears.

3. In the Name field, type XX Department Content Set (where XX is
your initials).

4. In the Segment field, select Department.

5. In the Parent Value field, select PT.
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6. Choose the Next button.

The next window appears.

7. Choose the following content set attributes:

In this field... Choose this option...
Include Parents and Children
Sort By Branch
Display Type Report/Total
Run Reports Sequentially

8. Choose the Next button.



3 – 20 Oracle Applications Desktop Integrator Tutorial

The next window appears.

You have the option to filter other segments and change their
display options, and to filter detail or summary balances.

9. Choose Finish to accept the defaults on this window and generate
the content set.

The following screen appears and includes a tree structure using
the same format as the Account Hierarchy Editor in General
Ledger.

10. Expand the Department 100 segment value by selecting the plus
sign (+) to the left of this value.

Both parent and children values are included in your content set.
You also have the option to export an expanded view of your tree
structure in tab–delimited format to an external file.

11. Choose finish to complete the generation process.

The content set you created is now available for use.
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Producing Reports With the Request Center

Earlier in this tutorial you learned that the Request Center monitors
concurrent requests that are submitted through ADI and that it notifies
you when those requests are complete.

In this section, you learn how to use the Request Center to submit,
monitor, and publish reports.

About the Request Center

The Request Center is a centralized reporting tool that you can use to
submit, monitor, and publish financial reports, standard (fixed format)
reports, standard (variable format) reports from all Oracle
Applications. You can publish to a web site, a database, an Excel
spreadsheet, or a plain text file while applying report themes.

Report themes are custom templates that you use to quickly format your
reports with colors, fonts, and a corporate logo. You can quickly
produce boardroom–ready reports without any additional effort.

When you publish your reports to a web page, you can leverage
Oracle’s publish, subscribe, and pull–on–demand report distribution
model. The Request Center publishes your report to a dedicated web
page on the corporate intranet so that you can provide information
online and on time. You can categorize your concurrent requests by
adding specific requests to a Hot List for immediate access in the
future.You can also attach a spreadsheet version of the report to your
web page so that readers can download the fully–formatted
spreadsheet report for further analysis.

When you want to publish your reports to a secured web site, you can
choose the security model that best fits your needs:

• User/Group–Based Security Provided by Web Server: The
Oracle Web Server provides a built–in security feature that
validates against the user and report relationships you manually
define for your web site.

• Security Rules in Oracle Database Enforced by Web Server:
Leverage the relationships between users and reports already
defined in your database.
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Request Center Features and Benefits

Because the Request Center
does this... You can...

Submits, monitors, and publishes
reports from a single report man-
agement tool

Save time and effort by using a
single point of interface for your
reporting needs.

Submits any financial, standard
(fixed format), or standard (vari-
able format) report

Conveniently submit reports
without logging into the applica-
tion. You can also monitor your
report submissions.

Publish: Automatically publishes
formatted report output to a web
page

Eliminate the resource–intensive
push report distribution model.

Subscribe: Allows interested us-
ers to view reports from a secure
web page

Control access to reports with
password protection for the web
page. Authorized users view in-
formation when they need it.

Pull on Demand: Downloads a
report in spreadsheet format di-
rectly from the web page

Use the corporate intranet more
effectively to distribute reports
for further analysis.

Provides the option of updating
the web page each time you run
the report.

Set up your web page once, and
refresh it automatically with the
latest information.

Optionally creates links in your
web page to each report when
using a content set to publish re-
ports broken out by segment val-
ue

Eliminate the need for multiple
web pages and reduces mainte-
nance.

Publish web reports that are bro-
ken out by segment values to
separate directories on your web
server

Secure access to your output and
determine the directories where
your reports reside on your web
server. You can then determine
the access rights to those directo-
ries.

Automatically downloads finan-
cial reports to Excel

Efficiently distribute and use re-
ports for further analysis.
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You can...
Because the Request Center
does this...

Enforces security rules by filter-
ing balances from reports based
upon user responsibility

Prevents unauthorized access to
financial information.

Allows you to change the content
set at report run time

Report financial results based on
past, present, or future reporting
hierarchies without creating and
ad hoc report.

Displays log and non–financial
reports using any word processor
or text editor

Access report details and non–fi-
nancial reports using familiar
desktop editors.

Creates customized themes to
use in formatting output at the
most granular level.

Easily standardize the presenta-
tion of report output and main-
tain a consistent look to your fre-
quently–run reports.

Monitors any concurrent requests
submitted from any Oracle Ap-
plication.

Have one–stop shopping for con-
current request monitoring and
review.

Organizes requests by status, and
provides a hot list for specific re-
quests.

Immediately locate and access
specific requests.

Sets selection criteria by user,
program, or request ID when ad-
ding jobs to watch.

Quickly find jobs to add to the
monitored list.

Schedules reports to run and au-
tomatically publishes them at a
later date and time.

Determine when you want to
submit reports.

Supports simultaneous connec-
tions to multiple databases.

Concurrently monitor requests
across multiple databases with-
out requiring users to repeatedly
connect and disconnect.

When you start ADI and connect to a database, the Request Center
starts and connects to the same database. However, you can also run
the Request Center independently of ADI by double–clicking the
Request Center icon.

The Request Center contains these tabs:
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• Pending tab. Displays concurrent requests that are pending or
running.

• Completed tab. Displays concurrent requests that are
completed. After a request is completed, the Request Center
moves it from the Pending tab to the Completed tab.

• Hotlist tab. Displays completed requests that you added to the
hotlist. The hotlist offers easy access to specific requests by only
listing the requests that you selected.

• Databases tab. Displays the databases that you defined. The
Databases tab also indicates the databases you are using.

The Request Center Toolbar

Restore the Request Center by choosing Applications from the ADI
toolbar and select Request Center from the List of Values. Select the
Completed tab and slowly drag your cursor across the Request Center
toolbar to show short descriptions of each button.

The Request Center toolbar buttons are explained below:

Submit Report: Submit any financial, standard (fixed format), or stan-
dard (variable format) report within Oracle Applications.

Show Request Details: Shows summarized data on submitted re-
quests.

Cancel Request: Cancel pending or running requests.

View Output/Log: Display the output, or log reports relating to a re-
quest.
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Report Manager: Use to publish and manage reports on the database.

Publish Output: Publish selected output to the Web, an Excel spread-
sheet, or a plain text file.

Format Report Output: Create and modify report themes.

Print Output/Log: Print the output or log reports to a selected printer.

Monitor Request: Use search criteria to select requests that you want
to monitor.

Add Request to Hotlist: Add selected request to the Hotlist tab.

Stop Monitoring Selected Request: Remove the selected request from
the current tab.

Stop Monitoring All Requests: Remove all requests from the current
tab.

Signon: Connect to a database. You can connect to multiple databases
simultaneously, allowing you to concurrently monitor requests across
multiple databases.

Disconnect: Disconnect from a database.
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Change Responsibility: Change to a different responsibility within
Oracle Applications.

Applications Desktop Integrator:  Logon to ADI, or if ADI is running,
maximize ADI.

Oracle Applications:  Logon to Oracle Applications.

Options:  Set Request Center options, such as toolbar icon size, the text
editor to use for viewing report outputs, and the sound played when a
request completes.

Help:  Access the online help features of the Request Center.

Minimize:  Minimize the Request Center.

Exit:  Close and exit the Request Center.

Request Pending:  Request Pending – dynamic button

Creating and Editing Themes

ADI currently offers three levels of formatting capability depending
upon the report type. At the most basic level, you can use themes to
customize company logos, background colors, and field widths. You
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can apply these basic themes to all report types – financial, standard,
and standard variable formats.

A step beyond these basics is region level formatting. With this
capability, you can customize output for elements such as report titles,
report headings, column headings, and line items. These features are
available for financial and standard (variable format) reports.

Finally, cell level formatting offers the most advanced functions. With
cell level formatting, you can specify characteristics such as fonts,
borders, indention, and alignment right down to each cell in your
worksheet. This feature is available for all financial reports.

Themes can be saved and applied to any report output that you
publish. You can edit existing report output themes and also create new
ones. In addition, ADI comes with some sample themes that are ready
to use.

� To create and edit themes for financial reports:

1. Maximize the Request Center, and choose the Format Report
Output button from the Request Center toolbar.

The following window appears:

2. Choose the Create button to create a report theme.

A menu appears containing the three report output type options.

3. Choose Financial Report from the menu.

ADI starts Excel and creates a basic theme worksheet similar to the
following example. You can then customize this basic theme.
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4. Choose the Customize button.

Note how the selections correspond to the key report components
displayed on the theme worksheet.

5. Choose Report Title from the selections.

The standard Format Cells window in Excel appears.

6. Change the background color, and choose OK. Choose OK again on
the Style window.

The background color for the Report Title is now the color you
chose.

7. Alternatively, you can double click on a cell in a report region and
change the options for that region. Double click on a cell in the Line
Item region.

8. Change the font to a different color, and choose OK. Choose OK
again at the Style window.

The font for the line items is now the font that you chose.

9. You can also choose a background for your report theme. Choose
the Background Find button.

The Request Center displays a list of background files.

10. Select the cream.bmp file, and choose Open.
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The background of the report is now a cream–colored pattern. The
path of the background picture appears on the worksheet in the
Background Picture field. Optionally, you can use the Find button
next to the path to select the background.

11. You can indicate where you want to publish your web reports. In
the Publish To field, type a path and file name (for example,
c:\temp\report1.htm) for the output.

The path appears in the Publish To area of the worksheet.
Optionally, you can use the Find button next to the path to select
where to publish this theme output.

12. Save the theme as XXtheme.xls (where XX is your initials). Your
theme can now be applied to published reports.

13. Close Excel, and close the Report Output Themes window.

� To format financial reports at the cell level:

1. From the Excel File menu, choose Open.

2. Navigate to your Oracle Home directory and choose gldi90 >
themes > vision11 > summaryincome_print.xls. This is a report
theme.

3. Download the report Sumary Income Statement into a separate
new workbook. This is the report definition worksheet.

See: Downloading an Existing Report: page 3 – 13.

4. From the Excel toolbar, choose Window > Arranged > Tiled. Your
screen should look like the following:
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Note the matching sequence numbers between the theme, summaryincome_turtle.xls and
the report definition worksheet.

ADI uses sequence numbers to locate the positions of rows and
columns in your report output. ADI matches the formatting
specified in your report theme with the information in your report
definition worksheet to generate formatted output, cell by cell.

5. Click on the theme, summaryincome_print.xls and maximize it.

6. Save the file as theme2XX.xls where XX is your initials.

7. Click on any cell in the Amounts region of theme2XX.xls.

8. From the Excel toolbar, choose Format > Cell. Choose the font tab.
Change the font, font style, font color, or font size. Choose the
border tab. Change the border, line style, or line color. Choose OK.

9. Click on the &ReportTitle token.

ADI uses tokens to reference information from the report definition
you set up in General Ledger. You can type the ampersand symbol
(&) and the token identifier to reference report titles, set of books
name, current period, currency, and more.



3 – 31Creating Reports

See the Applications Desktop Integrator User’s Guide for more
information on tokens available for your report themes.

10. Click the right mouse button to open the Excel toolbar. Choose
Format Cells. Choose the Alignment tab. Change the text
alignment. Choose OK.

11. Click on the cell containing the row sequence &15INCOME.

12. From the Excel toolbar, choose Format > Cell. Choose the Patterns
tab. Change the cell shading or pattern. Choose OK.

13. Highlight a column of cells in the Amounts region.

14. From the Excel toolbar, choose Format > Cell. Choose the Number
tab. Change the category to Percentage.

15. Click on the right Move Line Item Position button. Note that the
line item column moves to the right. This feature allows you to
place the line item text column anywhere within the amounts
region of the report.

16. Save your theme. Your theme can now be applied to published
reports.

17. Close Excel.

� To create and edit themes for standard (variable format) reports:

1. Make sure you are using an Assets responsibility.

2. Maximize the Request Center and choose the Format Report
Output button from the Request Center toolbar.

The Report Output Themes window appears.

3. Choose the Create button to create a report theme.

A menu appears containing the three report output types.

4. Choose Standard (Variable Format) Report.

The Create Theme Using Attribute Set window appears.
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5. From the Report poplist, select Asset Cost Balance Report. From
the Attribute Set poplist, select the Default attribute set. You can
also create personalized attribute sets. See:

ADI launches Excel and creates a basic theme worksheet similar to
the following example. You can then customize this basic theme.
Note that the columns in the theme reflect the information in the
attribute set.

Hint: Note the columns in your theme appear wide. To make the
columns narrower, choose Format > Column > Width and enter a
value, such as 15 or 20.

6. Choose the Customize button.

Note how the selections correspond to the key report components
displayed on the theme worksheet.

7. Choose Report Title from the selections.

The Excel Format Cells window appears.

8. Change the background color, choose OK. Choose OK again in the
Style window.

The background color for the Report Title is now the color you
chose.

9. Alternatively, you can double click on a cell in a report region and
also change the options for that region. Double click on a cell in the
Column Heading region.

10. Change the font to a different color, and choose OK. Choose OK
again in the Style window.
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The font color for the column headings is now the color that you
chose.

11. Highlight the cells in the first column. Right click and select Format
Cells. Change the pattern and choose OK.

The background for the first column is now the pattern that you
chose.

12. Highlight the cell in the third column on default_line_format. Right
click and select Format Cells. Change the number format on the
default_line_format so that it has no decimal places. This dictates
the format of the entire column. Choose OK.

13. You can also choose a background for your report theme. Choose
the Background Find button.

The Request Center displays a list of background files.

14. Select the blue.bmp file, and choose Open.

The background of the report is now a blue colored pattern. The
path of the background picture appears on the worksheet in the
Background Picture field. Optionally, you can use the Find button
next to the path to select the background.

15. ADI automatically supplies a valid path and filename. You can
change this if you want by typing a value.

 Optionally, you can use the Find button next to the path to select
where to publish this theme output.

16. Save the theme as XXtheme2.xls (where XX is your initials). Your
theme can now be applied to published reports.

Submitting Financial and Standard Reports

The Request Center provides you with a centralized facility for
submitting, monitoring, and publishing reports. You can choose your
report publishing method and determine when you want to run your
report. By selecting the Submit Report button you can access all of this
functionality in one central location. You can use the Request Center to
submit both financial reports or any standard report or listing in any
Oracle Applications.

In the following lesson, you submit a financial report, publish it to the
web, and download a spreadsheet version of the report from the web.
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� To submit a financial report:

1. Choose the Submit Report button on the Request Center toolbar.

The Report Submission and Publishing window appears.

2. You can choose to run a Financial, Standard (Fixed Format), or
Standard (Variable Format) report type. The report types determine
the options that are available in the Submission and Publishing
option areas.

3. In the Report Type field, check Financial Statement.

You can either run an existing financial report or create an ad hoc
report from financial report components, such as row sets and
column sets.

4. Select the Existing Report field, and type Summary Income
Statement.

5. In the Period field, select MAR–97.

6. Leave the defaults in the other fields, and choose the Publishing
button.

Next, you indicate if you want to publish to the web, a spreadsheet,
or a plain text file. You also select the report theme you want use.
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7. For the Output Type, choose Web.

8. For the Publish option, choose Prompt.

9. In the Themes region, choose the Find button to open the themes
directory.

10. Choose the file, vision 11\summaryincome_print.xls.

11. In the Publish To field of the Web Options region, ADI
automatically supplies a valid path and file name. You can change
this if you want.

12. Check Launch Browser, Include Spreadsheet, and Link Reports.

Your window should look similar to the following example:

13. Choose the Options button.

On this window, you can indicate:

• If you want to run your report at a later date and time

• If you want to print your output.

• A printing location.

14. For this lesson, leave the default values in these fields. Choose the
OK button to submit your report.
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The Report Submission and Publishing window closes, and the
following message appears:

15. Choose OK.

16. Choose the Pending tab in the Request Center.

Notice that your request is listed. When the request is complete, the
Request Center flashes. The request then appears on the Completed
tab.

When your request is complete, a message appears asking you if
you want to publish your output.

17. Select the Yes button.

The Request Center starts your web browser and applies your
theme to the report. Your report looks similar to the following
example.
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Note that the Request Center applied the Turtle theme to your
report. Also notice that a separate report was published for each
department. Since you selected the Link Reports option in the
Publishing window, ADI automatically establishes links to those
reports on your web page.

Note: The Request Center Messages window appears, detailing
information about the published request. This is especially helpful
when multiple requests complete at the same time.

18. Switch from the Department 402 report to the Department 404
report by selecting the Department 404 link on the left side of the
window.

19. When you defined your Publishing options, you selected to include
a spreadsheet with your web output. Notice the Excel icon in the
upper left corner of your window. Choose this icon to download
the Department 404 report to Excel.

The report downloads and opens as an Excel worksheet.
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20. Save your spreadsheet report for later use. Name the file
XXincome.xls (where XX is your initials).

21. Close Excel, and close your browser.

� To submit a standard report:

1. Maximize the Request Center, if it is not maximized.

2. Choose the Submit Report button.

3. In the Report Type field, choose Standard.

4. Choose the Report field, and type Chart of Accounts – Segment Values
Listing.

5. Choose OK.

6. Press the Tab key to enter the standard report parameters.

7. Select Department for the Segment Name.

Your screen will look like the following example:
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8. Choose the Publishing button.

9. In the Output Type region, select the Web option.

10. In the Themes region, choose the Find button to select
Cinnamon.xls as the report theme.

11. In the Publish To field of the Web Options region, ADI
automatically supplies a valid path and file name. You can enter a
different path and file name if you want.

Your screen should look similar to the following example:
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12. Choose OK to submit the report.

13. When the report is complete, select Yes to publish the output.

Note:  The Request Center Messages window appears,
detailing information about the published request. This is
especially helpful when multiple requests complete at the same
time.

The Request Center starts your browser and publishes your
standard report to the web.
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14. Notice the two options at the upper left corner of your screen. You
can Retrieve a Text File or View a Printable Copy. Select View a
Printable Copy.

The Request Center creates a version of your report that is sized to
fit your page for printing.

15. Close your web browser, and return to the Request Center.

Submitting Standard (Variable Format) Reports

Variable format reports allow you to customize the format of standard
report output for Asset reports only. You can choose which information
to include in the report, as well as how the information is placed and
sorted within the report.

� To submit a standard (variable format) report:

1. Maximize the Request Center if it is not maximized.

2. Choose the Change Responsibility button and select Assets, Vision
Operations (USA).

3. Choose the Submit Report button.
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4. In the Report Type field, choose Standard (Variable Format).

5. Choose the Report field and type Asset Cost Balance Report.

6. Choose OK.

7. Press the Tab key to enter the variable format report parameters.

8. Select OPS CORP for the Book.

9. Select Jan–97 for the Begin Period.

10. Select Jan–97 for the End Period.

Your display will look like the following:

11. Choose the Publishing button.

12. In the Publish region, select the Prompt option.

13. In the Output Type region, select the Spreadsheet option.

14. In the Themes region, ADI automatically supplies the seeded
Theme associated with this report, gldi90 > themes > variable >
asset_cost_bal.xls.

15. In the Attribute Sets region, choose the Actions button and select
New.
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16. Enter the name Attribute XX (where XX are your initials) in the
window that appears.

17. Drag and drop from the list of Available Attributes to the Selected
Attributes region below.

18. Use the Ascending, Descending, and Group By buttons to apply
sorting and grouping characteristics to the Selected Attributes
columns.

19. Move columns within the Selected Attributes grid to specify the
order in which they should appear in the report.

20. Save your work.

Your display should look like the following:
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21. Choose OK to submit the report.

22. When the report is complete, select Yes to publish the output.

The Request Center starts your browser and publishes your
variable format report to a spreadsheet.

The Request Center Messages window appears, detailing
information about your request. This is especially helpful when
submitting multiple requests.

Managing Requests

� To view request logs:

1. Choose the Completed tab, and ensure that your last report is
highlighted.

2. Choose the View Output/Log button in the Request Center toolbar,
and choose View Log File.
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The log gives information about the processing of your request. It
can be useful in diagnosing errors in your concurrent requests.

3. Close the log.

� To add requests to the Hotlist:

You can add specific requests to the Hotlist for easy access.

1. Select a request on the Completed tab.

2. In the Request Center toolbar, choose the Add Request to Hotlist
button.

3. Choose the Hotlist tab. Your request appears on the hotlist.

4. Select this request. In the Request Center toolbar, choose the Stop
Monitoring Selected Request button.

Notice that the request is no longer in the Hotlist tab.

You can clear out all your requests on the hotlist with the Stop
Monitoring ALL Requests button. You can clean out your list of
completed requests periodically, yet still maintain easy access to
important requests.
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Monitoring Requests Across Multiple Databases (Optional)

Skip this lesson unless you have access to multiple databases.

You can connect to multiple databases using the Request Center and
concurrently monitor requests across all databases that you are
connected to.

� To monitor requests across multiple databases:

1. Choose the Databases tab.

A list of all databases that are defined in either the Request Center
or ADI appears.

2. Select any database to which you are not already connected, and
press the Signon button in the Request Center toolbar.

3. Enter your username and password, and then choose OK.

4. Choose the Monitor Request button, and select the database.

You are now connected to two databases, and you can monitor
concurrent requests from both.

Cancelling Requests

You can cancel pending requests or requests which are still running
from the Request Center.

� To cancel requests:

1. Select a request from the Pending tab.

2. Choose the Cancel Request button from the Request Center toolbar.
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A confirmation message is displayed. Select Yes to cancel the
request.

3. Choose the Completed tab. Note that the cancelled request is
displayed with a status of either Cancelled or Terminated. The
Cancelled status indicates that the request was still pending at the
time it was cancelled. The Terminated status indicates that the
request was already running at the time it was cancelled.
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Analyzing Reports

This chapter contains lessons that explain how to perform the following
tasks:

• Drill down through balances

• Integrate with other desktop applications
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Drilling Down Through Reports Using the Analysis Wizard

In this section, you learn how to drill down from spreadsheet reports
using the Analysis Wizard.

About the Analysis Wizard

The Analysis Wizard combines dynamic report drilldown with OLAP
analysis capabilities. It performs online report drilldown completely
within the desktop environment. You can select individual amounts
from spreadsheet reports and drill directly into the underlying financial
details.

The Analysis Wizard presents the complete range of accounts which
support a particular reported amount, including summary accounts,
detail accounts, and journals.

The versatility of the Analysis Wizard increases productivity by
enabling you to quickly detect trends and exceptions in financial data
and simultaneously expand the organization’s knowledge of the
relationships between components of financial information.

With the Analysis Wizard, you can do the following:

• Drill into the Oracle Applications database real time so that you
are assured that the financial information is the most accurate
and up–to–date available.

• Tailor your view of the financial information by using drill
options and drop down menus, enabling them to display account
descriptions and filter out unneeded accounts.

• Drill across multiple periods within a single window, including
period–to–date, quarter–to–date, year–to–date, and life–to–date
balances.

• Pivot financial information online to work through what–if and
what–happened scenarios, rather than writing several custom
reports.

• Using drag and drop functionality, you can sort accounting
dimensions, such as charts of accounts, periods, and ledgers
within a multidimensional view to quickly reorganize summary
and detail financial information.

Alternatively, you can compare figures across multiple business
units, departments, or product lines to pinpoint a specific piece
of information.
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Analysis Wizard Features and Benefits

Because the Analysis Wizard
does this... You can...

Provides the ability to drill di-
rectly from spreadsheet reports
into account details in Oracle
General Ledger, Accounts Re-
ceiveable, and Accounts Payable.

Perform analysis on spreadsheet
reports to determine the account
details that make up a particular
amount.

Has multidimensional analysis
capabilities to pivot your ac-
counting dimensions in real time.

Reorganize financial information
on the fly, rather than writing
several custom reports.

Enforces segment value security
rules during drilldown.

Secure sensitive accounting in-
formation against unauthorized
viewing.

Dynamically drills into underly-
ing details without having to pre-
define drilldown paths.

Perform value–added analysis
quickly because you avoid wast-
ing time on non–value added ac-
tivities, such as defining drill-
down paths.

Drills between multiple levels of
detail, including summary ac-
counts, detail accounts, journal
lines, and subledger details.

Access the level of accounting
details appropriate to the finan-
cial information that you require.

Drills across multiple periods, in-
cluding Period–To–Date, Quar-
ter–To–Date, Year–To–Date, and
Life–To–Date balances.

Simultaneously view several pe-
riods of financial information to
detect trends and exceptions in
your data.

Drills across multiple sets of
books.

Simultaneously view financial in-
formation across sets of books to
compare and contrast reported
amounts.

Simultaneously drills into multi-
ple reported amounts.

Easily compare different reported
amounts online.

Allows you to change periods or
Amount Types during drilldown

Analyze another period or create
a trend analysis without generat-
ing a new report.
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You can...
Because the Analysis Wizard
does this...

Drills into underlying financial
details in real time.

Analyze reported amounts using
the most accurate and up–to–
date financial information avail-
able.

Drilling focuses only on the re-
ported amount you choose.

Drill only into the amount you
are interested in, without creating
unnecessary layers of spread-
sheets.

Automatically saves the results
of your analysis into formatted
spreadsheet, or to the clipboard
for further analysis.

Store the results of your analysis
with your spreadsheet report for
further distribution and easy ac-
cess.

Analyzing a Report Balance

The Analysis Wizard provides you with insight into the underlying
financial details for a selected balance in a report.

In this lesson, you use the Analysis Wizard to drill down on a balance
in the Summary Income Statement that you ran in the Request Center
section of this tutorial.

� To drill down on a balance:

1. Maximize the ADI toolbar.

2. Start Excel and open the Summary Income Statement Spreadsheet
Report that you downloaded from the web in the previous lesson.
Your screen will look similar to the following example:
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You will now use the Analysis Wizard to drill down on an amount
in the Income Statement.

3. Select the Operating Expenses balance for the period QTD–Actual
Jun–97.

4. Choose General Ledger from the ADI toolbar and select Analyze
Report from the List of Values. The Context window appears.
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The Context window shows all the attributes of the number that
you drilled down on. Notice that there are two effective ranges for
the number you drilled.

5. Select View/Filter to see the ranges. Note that you can focus your
drill by selecting the ranges you want to analyze.

6. Select OK to exit this screen.

� To view drill options:

Notice the reference region at the bottom of this window. It
includes the Drill Options button and the Data Source button.

1. Choose the Drill Options button. The following window appears:

2. Ensure that Show Outline Indicators is checked.

You can include descriptions for your account segments.

3. Choose OK to exit the window.

� To show detail accounts:

You will now drill down to the detailed accounts that aggregate into
the number that you selected.

1. Choose the Show Detailed Accounts button.
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2. Maximize the Detailed Balances – Net window to better view the
information. The following window appears:

Notice that the total amount reconciles to the amount you drilled
down on.

Using Dimensions and Display Options

You can use Analysis Wizard’s OLAP capabilities to pivot your report
dimensions in real time. This feature enables you to work through
what–if and what–happened scenarios, rather than writing several
custom reports.

Notice that the Analysis Wizard created a matrix showing the detailed
accounts by period. The matrix has three dimensions: page, row, and
column. The current window only has two: row and column. The row
dimension values are the flexfield segment values and the column
dimension values are time. Let’s change our view of the data by
manipulating our dimension values.
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� To use dimensions and display options:

1. Click on the Company dimension value and drag it to the upper
left corner of the window below the Analysis Wizard toolbar.

2. Do the same with Sub–Account and Product.

Company, Sub–Account, and Product are now page dimensions.

3. Move the Account and Department dimensions by dragging them
to the column area.

4. Right click on the Period dimension and choose Move to Row.

Your window looks similar to the following example:

5. Select the down arrow on Period to display the data values for
Period. Notice that Apr–97, May–97, and Jun–97 are selected.

6. Uncheck Jun–97.

Your matrix now displays only values from Apr–97 to May–97.

7. Move the Period dimension back to the column area.

8. Check Jun–97 in the list in the Period field.

9. Move the Department and Account dimensions back to the row
area.
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10. Move the Company dimension back to the row area, before
Department.

11. Move the Sub–Account and Product dimensions to the row area
after Account.

Your window looks like the following example:

You can control which values are displayed in your window in
several ways.

The minus sign (–) next to the Company segment value, 01,
indicates that all the values for Company 01 in the matrix are
expanded.

12. Choose the minus sign to collapse all the values for Company 01.

The values for Company 01 are now collapsed, as indicated by the
plus sign.
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13. Choose the plus sign to expand Company again.

14. Another way to control the values is to right click in the row or
column. Place the cursor anywhere in the Account column and
right click.

A drop down menu appears. Note all the options, and choose Filter
Values.

You will use a shortcut to select Account 7210.

15. Choose the None button to deselect all the values.

16. Select the value 7210, and choose OK.
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The window only shows the account that contains Account 7210.
Note that your totals have changed to reflect the accounts that you
have filtered out.

17. Right click on Acct again, and select Show All Values.

The window once again show all accounts.

� To show journal detail:

You can use the Analysis Wizard to show journal details for almost any
number. You can see the journal transactions that make up a number or
examine transactions imported from Accounts Receivable or Accounts
Payable.

1. Select the value for Account 01.404.7110.0000.000 for Apr–97.

2. Choose the Show Journal Details button.

The following window appears:

Notice that two journal entries make up your balance. You can
display multiple fields at the same time.

3. Select Batch Name and drag it to the row heading between Line
and Description.

The Batch Name appears.

You can also view subledger transaction activity supporting journal
entries for Oracle Accounts Receivable and Payables.
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� To show subledger detail:

1. Select the value for the Batch Name Payables 10350.

2. Choose the Show Subledger Details button.

3. Maximize the Subledger Details window to better view the
information. The following window appears:

The Analysis Wizard can drill down to the exact transactions that make
up the balances on your reports, all from the spreadsheet.

4. Choose the Return to Journal Details button.

5. Choose the Return to Detail Accounts button.

� To export data to Excel

With Analysis Wizard, you can store the results of your analysis
with your spreadsheet report for further distribution and easy
access.

1. In the Analysis Wizard toolbar, choose the Export to Excel option.

The Export to Spreadsheet window appears.
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2. In the Export field, choose Current Window.

3. In the Workbook field, choose Current.

4. Choose the Finish button to export to Excel.

5. Maximize Excel. The following window appears.
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Changing Report Attributes and Creating Adhoc Trend Reports

You can change your report attributes to analyze another period or
amount type, or even create a trend report on the fly. This feature
allows you to create adhoc reports without requiring you to define
another FSG report. You can export the results to an Excel spreadsheet.

� To change Report Attributes and create Adhoc Trend Reports:

1. Select the Analysis Wizard Context Window and change the period
to Oct 98.

2. Change the amount type to Y–T–D Actual.

3. Choose the Drill Options button from the toolbar and select:

• Display Segment Values Individually

• Show Outline Indicators

• Include Descriptions for Account

4. Choose the Show Detail Accounts button.

5. Move the Co, Dpt, Sub, Prd, and Qtr dimensions to the top.

6. Select Account Dimension and filter accounts 7110, 7120, 7210,
7220.

7. Choose the option, Export the Adhoc Report to Excel.

8. In the Export field, choose Current window.

9. In the Workbook field, choose Current.

10. Choose the Finish button to export to Excel.

11. Maximize Excel.

You have created an adhoc report for the months January to
October 1998 for accounts 7110 to 7220. You were not required to
create a report dimension.

12. Exit Analysis Wizard.



4 – 15Analyzing Reports

Integration With Other Desktop Applications

So far, this tutorial has shown how ADI integrates with a spreadsheet.
In this section, you learn how to integrate ADI with other desktop
applications, such as word processors or presentation applications.

Suppose that you deliver a summary reporting package to senior
management at the end of every month. The reporting package
includes several financial statements plus a cover page.

� To integrate with other desktop applications:

1. Create a sample cover page by starting Word and typing:

2. Return to the Summary Income Statement output on Excel.

3. Select the Revenue Net of Discounts balance for PTD APR–97 for
West Region Sales from your report output.

4. Choose Copy from the Edit menu.

5. Return to Microsoft Word.

6. Click to the right of Revenue for West Region Sales is.

7. Choose Paste Special from the Edit menu. Choose to paste a link.
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The net revenue number appears.

8. Save the document, and exit Word.

9. Rerun the Summary Income Statement report for JUL–97.

10. Choose the same publishing options that you selected when you
ran this report in the Request Center section of the tutorial.

11. Choose OK, and submit the report.

12. When the report is complete, choose Yes to publish the report.

13. Switch to the 404 West Region Sales report, and download the
report.

14. Overwrite the old version of the report by giving it the same name
as the old file.

15. Start Word, and open the saved cover page document.

The link that you pasted into the Word document is maintained
and the net revenue number is updated.

Your entire monthly reporting package is now automated by
integrating ADI with Excel and Word.
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Account Hierarchy
Editor

This chapter contains lessons that explain how to perform the following
tasks:

• Define accounts

• Create new account hierarchies

• Duplicate hierarchies

• Modify groups of descriptions within a hierarchy
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Defining Accounts with the Account Hierarchy Editor

In this section, you will learn how to create, maintain, and view
account structures using the Account Hierarchy Editor. You will also
duplicate existing hierarchies to create time–based hierarchies that can
be used in content sets to generate reports using the Report Wizard.

About the Account Hierarchy Editor

With the Account Hierarchy Editor you can create, maintain, simulate,
view, and print account hierarchies. The Account Hierarchy Editor’s
drag and drop graphical user interface is intuitive, flexible, and easy to
learn. Use the Account Hierarchy Editor with Financial Statement
(FSG) Content Sets to quickly create time–based reporting structures.

Because the Account Hierarchy
Editor does this... You can...

Provides a graphical
representation of account
hierarchies that can be viewed,
manipulated, and printed

Quickly and clearly understand
complex organization and
account structures.

Uses a simple drag and drop
interface to build and modify
your organization

Rapidly reorganize business
entities (cost centers, accounts,
etc.). View the results of these
changes immediately in
organization structure, financial
statements, internal reports and
more.

Provides a single location for
creating and maintaining child
segment values, parent segment
values, and rollup groups

Maintain your chart of accounts
in one location, eliminating the
need to move among multiple
screens.
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You can...
Because the Account Hierarchy
Editor does this...

Allow only those users with
proper authorization to modify
hierarchies

Allow all users to view and print
hierarchies while ensuring that
only authorized users can modify
and save changes to the account
hierarchies.

Allows you to copy a hierarchy
then make changes to that
hierarchy without affecting the
original

Create what–if and scenario
based hierarchy reporting. Copy
an existing hierarchy, modify it
and compare the new hierarchy
to the original to analyze
potential changes in your
organization.

Opening the Account Hierarchy Editor

To view or work with account hierarchies, first open the Account
Hierarchy Editor and define the chart of accounts you wish to view,
modify, or duplicate.

� To open the Account Hierarchy Editor:

1. Choose ledger from the ADI toolbar and select View Account
Hierarchy from the list of values.

2. Select the Operations Accounting Flex as the chart of accounts you
wish to modify.

3. Select the Department segment as the segment value you want to
modify.

Finding Segments

You can easily look for segments in your hierarchy by searching for the
segment value or description.
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� To find segments in the Segment Values window:

1. Highlight any segment value in the Segment Value window. For
example, highlight New child value.

2. Click your right mouse button and choose Find. You can also select
Find from the Edit menu.

The Find Segment window appears.

3. Specify the following:

In this field.... Specify or choose......

Find What PT

Parent check

Child unchecked

Match Case unchecked

Match Whole Words Only unchecked

Search For Segment Value

Direction Down

Table 5 – 1    (Page 1 of 1) Completing the Find Segment window.

4. Select Find Next.
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5. The Segment Value PT should now be highlighted in the Segment
Value window.

6. Select Cancel to close the Find Segment window.

Viewing Account Hierarchies:

You can use the Account Hierarchy Editor to view any existing
hierarchy. Once you have your hierarchy in the Hierarchy Diagram
window, you can modify or duplicate the hierarchy or change
descriptions in the hierarchy.

� To view and modify an existing account hierarchy:

1. Drag and drop the parent value PT from the Segment Values
window to the Hierarchy Diagram window.

Your hierarchy is be displayed. Parent PT is the parent of parent
values 100, 200, 400, 500, 700, and 800.

2. Remove the 100 value from this hierarchy by highlighting it and
dragging to the Segment Values window.

3. Double–click on PT to open the Parent Attributes window.

4. Place your cursor in the Ranges window.

5. Highlight Parent 200–>200.
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6. Select the Delete button to remove 200 from the PT parent.

7. Click OK to close the window.

The PT parent should now only have child values 400, 500, 700, and
800.

8. Remove the PT parent hierarchy from the Hierarchy Diagram
window by dragging and dropping it back to the Segment Values
window.

Creating New Account Hierarchies:

You can create new hierarchies by choosing New Parent Value in the
Segment Value window.

� To create a new account hierarchy:

1. Double–click the New parent value icon in the Segment Values
window.

The Parent Attributes window appears.

2. In the Segment Value field, enter <XX>0, where XX is your initials.
In the Description field, enter Raspberry.



5 – 7Account Hierarchy Editor

Note:  You will use this description in the next section.

3. Skip the remaining fields, then select the New button.

The Range window appears.

4. Select the Parent Range check box.

5. Enter 100–200 in the Range fields.

6. Click OK in the Range window and click OK in the Parent
Attributes window.

Your new hierarchy has been created.

Finding Segment Descriptions

You can search for segment descriptions using the Find Segment
window.

� To find a segment value using its description:

1. Place your cursor on the New Parent value icon in the Segment
Values window.

2. Click your right mouse button and choose Find. You can also select
Find from the Edit menu.

The Find Segment window appears.
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3. Specify the following to find the parent value you created in the
previous section:

In this field.... Specify or choose......

Find What Your initials, or the description Raspberry

Parent check

Child unchecked

Match Case unchecked

Match Whole Words Only unchecked

Search For Segment Decription

Direction Down

Table 5 – 2    (Page 1 of 1) Finding Segment Descriptions

4. Select Find Next.

Your <XX>0 parent should be located.

5. Drag and drop your <XX>0 parent value to the Hierarchy Diagram
window.

6. Add the following parents to your <XX>0 hierarchy by dragging
and dropping them from the Segment Values window to the
Hierarchy Diagram window.

Make parent 300 a child of parent 200.

Make parent 400 a child of parent 300.

Make parent 500 a child of parent 400.

7. Save your work by choosing the Save icon.

Duplicating Hierarchies

Duplicate any existing hierarchy. You can rename lower level parent
levels in any hierarchy you wish to duplicate.
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� To duplicate a hierarchy:

1. Select the <XX>0 parent in the Hierarchy Diagram window. The
entire hierarchy is highlighted.

2. Use your right mouse button to select Edit > Duplicate Hierarchy.

The Duplicate Hierarchy window appears.

3. Complete the fields in the Duplicate Hierarchy window as follows:
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In this field... Enter this
value...

Comments

New Top Level Par-
ent

Y99 You are entering the new top level parent val-
ue.

Description Pineapple

Find Parent ??0 You are instructing the system to find any
three character parent values that ends with 0.

Replace With ??9 You are instructing the system to replace any
third character 0 it finds with 9.

In Parent Level 2 You are instructing the system to search for
and replace parent values in the second level
of the hierarchy.

Table 5 – 3   (Page 1 of 1) Duplicate hierarchy window

4. Choose the Add button to populate the Replacement Order
window.

5. Return to the Replace Lower Level Parent Value(s) region and
complete the following fields:

In this field... Enter this
value...

Comments

Find Parent ??0 You are instructing the system to find any
three character parent values that ends with 0.

Replace With ??Y You are instructing the system to replace any
third character 0 it finds with 9.

In Parent Level 3 You are instructing the system to search for
and replace parent values in the third level of
the hierarchy.

Table 5 – 4   (Page 1 of 1) Duplicate hierarchy window

6. Choose the Add button to move your replacement criteria to the
Replacement Order window.

7. Return to the Replace Lower Level Parent Value(s) region and
complete the following fields:
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In this field... Enter this
value...

Comments

Find Parent ?0? You are instructing the system to find any
three character parent values that have a se-
cond character value of 0.

Replace With ?A? You are instructing the system to replace any
second character 0 it finds with A.

In Parent Level ALL You are instructing the system to search for
and replace parent values in all levels of the
hierarchy.

Table 5 – 5   (Page 1 of 1) Duplicate hierarchy window

8. Choose the Preview button.

A third Hierarchy Diagram window appears with your duplicated
hierarchy.

9. Choose the Accept button.

Note how the descriptions, child values, and other attributes were
copied to the new hierarchy.



5 – 12 Oracle Applications Desktop Integrator Tutorial

Modifying Groups of Descriptions in a Hierarchy

In the Modify Node Descriptions window, you can modify groups of
descriptions in a hierarchy quickly. This feature works well when you
need to duplicate hierarchies and rename lower level parent segment
descriptions.

� To modify groups of descriptions within a hierarchy:

1. Select the Y99 parent you just created in the Hierarchy Diagram
window.

The entire hierarchy is highlighted.

2. Note the descriptions of the parent and child values.

3. Use your right mouse button to select Edit > Modify Node
Descriptions.

The Modify Node Descriptions window appears.

4. Complete the Modify Node Descriptions window as follows:

In this field... Enter this value...

Find What Sales

Replace With Equipment
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Enter this value...In this field...

Level ALL

Parent checked

Child checked

Table 5 – 6    (Page 2 of 2) Modify Node Descriptions

5. Choose the Find button.

The lower portion of the window shows the results of your search.
Notice that your New and Old descriptions are displayed. The
checkmarks indicate that you want to change the description of the
segment value. Clear the checkmark to preserve the original
description.

6. Click inside the New Description field and click your right mouse
button.

The Rename menu appears.

7. Rename the description with Banana.

8. (Optional) Clear the checkmark from one or more segment values.
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9. Choose Replace.

10. Save your work.

Time–Based Reporting

You can create point–in–time snapshots of your organizational
structure, in the form of content sets and then reuse them in subsequent
periods for comparative analysis. As a result, you can run reports that
compare similar items even if your organizational structure changes.

In a previous section you created the XX Department Content Set based
upon the structure of value PT in Department Segment Value Set. Then
you modified the PT structure to remove the value 100 resources. The
XX Department Content Set you defined will remain static, even
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though the structure has changed since it was first defined. If you want
to establish the new reporting structure in a content set, you need to
create a new content set.
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Creating Assets and
Reconciling Physical
Inventory

This chapter contains lessons that explain how to perform the following
tasks:

• Create Assets

• Record and reconcile Physical Inventory
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Creating Assets Using ADI

In this section, you will learn how to create assets using ADI. Before
starting this section of the tutorial, you must first change your
responsibility to Assets, Vision Operations.

About the Create Assets Feature

ADI provides a spreadsheet–based interface to simplify asset creation
in a disconnected environment.

Use ADI’s Create Assets feature to:

• Automatically build personalized asset entry spreadsheets based
on the information required by your organization’s specific
implementation of Oracle Assets.

• Enter your asset data manually, use the list of values, and take
advantage of Excel’s data entry shortcuts.

• Map data files from legacy systems or third party applications
into the asset worksheet.

• Save an asset spreadsheet on your PC and work on it at any
time.

• Automatically upload the data into Oracle Assets when you are
satisfied with the worksheet.
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Create Assets Features and Benefits

Because ADI does this...... You can.....

Automatically define and
generate personalized
spreadsheet–based asset creation
worksheets.

Tailor the asset worksheet to
your data entry requirements –
include only the information that
you want to enter.

Enables quick asset entry
through spreadsheet Cut, Copy,
and Paste functionality.

Maximize productivity by de-
creasing the necessary keystrokes
to enter data.

Provides Lists of Values for easy
access to valid field information.

Ensure accuracy since the need to
manually look up valid field en-
tries is eliminated.

Maps data files into asset
worksheets when used with the
Import Text File feature.

Convert data from legacy asset
systems without writing custom
SQL scripts. Bridge the gap be-
tween third party payables sys-
tems and Oracle Assets using a
spreadsheet based interface.

Defines asset layout templates
which can be modified and
reused.

Enter assets by defining an asset
layout once, then using the lay-
out to build consistent work-
sheets whenever necessary.

Full validation of accounts with
enforcement of security and cross
validation rules, as well as other
reference fields.

Get real time feedback on errors
to correct them on the spot,
building efficiency.

Building an Asset Worksheet

To build an asset worksheet, you specify the elements that you want to
use:

• Corporate Depreciation Book: An asset can belong to any
number of depreciation books, but must belong to only one
corporate depreciation book. You must assign a new asset to a
corporate depreciation book before you can assign it to any tax
books.
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• Layout Template: Layout templates allow you to select the fields
that should be included in the asset worksheet. They also control
the order in which the data fields appear on your worksheet.
Layout templates are saved in the database and can be edited,
viewed, copied, renamed, or created from scratch.

Based on your choices, ADI automatically builds the asset worksheet.

� To build your asset worksheet:

1. Choose the Assets icon from the ADI toolbar and select Create
Assets from the poplist.

The Create Assets window appears.

2. Choose OPS Corp from the Select Corporate Depreciation Book
poplist.

3. Next, we will define a layout for your spreadsheet. You can choose
an existing layout or select a defined layout from the Select Layout
poplist.

We will create a new layout for your spreadsheet. Select the
Actions button (pencil icon) and Select New from the poplist.

The Actions button displays tasks that you can perform with
Layout Templates. Layout Templates are saved in the database and
can be reused.

Below is a list of options you may choose using the Actions button:

New: Choose this option to create a new layout template.
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View/Edit: Choose this option to view or edit an existing layout
template.

Note:  When you choose this option when the default template
is selected, you have the option only to view the default
template. You cannot edit the default template.

Copy: Choose this option to copy an existing layout template.

Rename: Choose this option to rename an existing layout template.

Note:  You cannot rename the default template.

Delete: Choose this option to delete an existing layout template.

Note:  You cannot delete the default template.

4. For the layout name, type your initials and Asset Layout.

The Edit Layout window appears. This window shows the list of
available fields that can be included in the asset worksheet. You can
drag and drop fields from the Available Fields region to the Header
and Lines grids to create the layout template. You can also
re–sequence the fields by using the directional arrow buttons.
Required fields that must be assigned to either the Header or Lines
grids are marked with a red asterisk.
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5. Use your mouse to drag and drop the following fields from the
Available Fields grid into the Header grid.

Accounting Date

Asset Type

Depreciate

In Physical Inventory

6. Use your mouse to drag and drop the following fields from the
Available Fields grid into the lines grid.

Location

Category

Units

Cost

Description

Expense Account

Clearing Account

Date Placed in Service

7. Choose one of the fields in the Header grid. Use the directional
arrow buttons to re–sequence the fields.

8. Choose one of the fields in the Lines grid. Use the directional arrow
buttons to re–sequence the fields.

9. Choose OK in the Edit Layout window. Choose OK in the Create
Assets window.

ADI creates an asset worksheet that reflects your choices. Your
asset sheet should look similar to the following:
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Please note:

• The asset worksheet header and lines regions list the fields you
chose, in the sequence you chose.

• The Accounting Date defaults to today’s date.

• The Asset Type defaults to Capitalized.

• Depreciate defaults to Yes.

• In Physical Inventory defaults to Yes.

Entering Asset Data

You can enter information into the asset worksheet either manually or
by using the Import Text File feature to map data from a text file into
the asset worksheet.

Begin by using the Import Text File feature to populate the asset
worksheet with data from an external source.
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� To enter data into an asset worksheet:

1. Choose the Assets icon from the ADI toolbar and select Import Text
File from the poplist.

The Import Assets Text File window appears.

2. In this Field... Select...
Source File OracleHome\GLDI90\ASSET.TXT
First row contains field names Checked
Delimiter Tab

3. Choose the Actions button in the Import Assets Text File window.
Select New from the poplist.

The Actions button displays tasks that you can perform with
Mapping Templates. Mapping Templates are saved in the database
and can be reused.

4. For the mapping template name, type your initials and Asset Map.
Choose OK.

The Mapping window appears. This window shows the list of
fields that are in the source text file, and the list of fields that are in
the asset spreadsheet. You can use either the directional arrow
buttons or simply drag and drop fields form the Import Files Fields
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region to the corresponding field in the Excel Spreadsheet Fields
region.

5. Use your mouse to drag and drop fields from the Import File Fields
region to the corresponding field in the Excel Spreadsheet Fields
region.

6. Choose OK in the Mapping window. Choose OK in the Import
Assets Text File window.

ADI maps the data from the source file into the asset worksheet you
created.

Your asset worksheet should look similar to the following:
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Note:

• The data from the source text file has been mapped to fields in
the asset worksheet. The mapping was accomplished for the
fields you chose, in the pairing you chose.

• Upload flag is set for every row in the asset worksheet that was
mapped from the source text file.

7. Double–click on any Location segment field (Country, State, City,
etc.) on the twenty–third worksheet line.

The Select Location Flexfield Values window appears, where you
can type each segment value or choose from the lists of valid
values.
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8. Choose the Country field. From the list of values, choose Country
USA.

These values are validated real–time against the values defined in
Oracle Assets. Notice that ADI displays the description.

9. Type CA in the City value field.

Even without using lists of values, ADI provides real–time
validation of your account values. ADI supplies the description,
California, which corresponds to State CA.

10. Choose the City field. From the list of values, choose City San
Francisco.

11. Type None in the Building value field.

12. Double–click on either Category segment field (Major or Minor) in
the twenty–third worksheet line.

The Select Category Flexfield Value window appears, where you
can type each segment value or choose from list of valid values.
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13. Choose the Major Category field. From the list of values, choose
Category Computer.

14. Type NC in the Minor Category value field.

15. Enter Units of 10 for this asset.

16. Enter a Cost of 500 for this asset.

17. Double–click on any Clearing Account segment field (Co, Dept,
Acct, etc.).

The Select Acounting Flexfield window appears, where you can
type each segment or choose from list of values.

18. ADI reflects default segment values as defined in Oracle General
Ledger. Leave the default value of 01 for Company.

19. Choose the Department field. From the list of values, choose
Department 000.

These values are validated real–time against the values defined in
Oracle General Ledger. Notice that ADI displays the description.

20. Type 1570 in the Account value field.

Even without using lists of values, ADI provides real–time
validation of your account values. ADI supplies the description,
Asset Clearing, which corresponds to account 1570.

21. Leave the default values for Sub–Account and Product.

22. Double–click on any Expense Account segment field (Co, Dept,
Acct, etc.).
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The Select Accounting Flexfield window appears, where you can
type each segment or choose from the list of valid values.

23. ADI reflects default segment values as defined in Oracle General
Ledger. Leave the default value of 01 for Company.

24. Choose the Department field. From the list of values, choose
Department 480.

These values are validated real–time against the values defined in
Oracle General Ledger. Notice that ADI displays the description.

25. Type 7360 in the Account value field.

Even without using lists of values, ADI provides real–time
validation of your account values. ADI supplies the description,
Depreciation Computers & Software, which corresponds to account
7360.

26. Leave the default values for Sub–Account and Product.

27. Enter a Date Placed in Service of 3/1/97 for this asset.

Uploading Asset Entries

Now that you’ve entered asset data into your worksheet, you are ready
to upload it to Oracle Assets.
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� To upload asset entries:

1. Choose the Assets icon from the ADI toolbar and select Upload to
Interface from the poplist.

The Upload Assets to Interface window appears.

2. For the Rows to Upload option, choose Flagged Rows.

3. Check the Create Assets Now (Post) option.

The Asset Status automatically defaults to Post. When the Asset
Status is set to Post, the upload process validates all asset data:
verifies field type and length, performs flexfield validation, checks
cross–validation rules, enforces segment security, and ensures that
data for all required fields has been entered.

If the Create Assets Now option is not selected, the Asset Status
may be set to New or On Hold. In this case, full validation is again
performed on the data entered in the asset worksheet, but blank
entries in the required data fields are accepted.

4. Choose OK to start the upload.

ADI uploads your flagged rows to the Oracle Assets mass
additions interface table. It then starts the post mass additions
concurrent process, which runs on the server.

The concurrent process creates asset entries in Oracle Assets, based
on the information in the interface table. ADI displays a message
that looks similar to the following:
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The message informs you that the post mass additions concurrent
process has started. It runs in the background, so you can continue
using ADI while the process completes. The Request Center
notifies you when the process completes by blinking at the bottom
of your screen, and by playing sound if your PC can play sound
files.

5. Notice that a batch id has been automatically assigned to the
uploaded entries. The batch id is displayed in the Header region of
the asset worksheet, and allows you to easily track uploaded
entries in the Mass Additions table in Oracle Assets.

6. Notice that the Messages column in the asset worksheet displays a
green success indicator in each row that was uploaded. To enable
this feature, go to the ADI toolbar and select the Options icon.
Choose the Settings tab in the window that appears. Be sure that
the Show Upload Success check box is marked.

During upload, ADI validates your accounts and reference fields,
such as Category and Location. If you entered invalid values for
any of these fields, ADI displays an error message when you
upload. For example, if you entered an invalid category, you will
see the following:
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In this case, you can use the list of values to choose a valid
category, and then upload again.

Verifying the Asset Upload

After the Request Center notifies you that the post mass additions
process is complete, you can verify that your asset was created in
Oracle Assets.

� To verify the asset upload:

1. Start Oracle Assets.

2. Choose Inquiry > Financial Information from the Navigator
window.

3. In the Find Assets window, you can use the poplist to Find assets
by Detail, Assignment, Invoice, Lease, or Project. Select Find by
Assignment.

4. Enter the Corporate Book, OPS Corp. Choose the Find button to
query the assets.
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Recording Physical Inventory Using ADI

In this section, you will learn how to record physical inventory using
ADI.

About the Record Physical Inventory Feature

The Record Physical Inventory feature provides a spreadsheet–based
interface to simplify the physical inventory process.

Use the Record Physical Inventory feature to:

• Automatically build personalized inventory spreadsheets based
on the information required by your organization’s specific
implementation of Oracle Assets.

• Enter your inventory data manually, use the list of values, and
take advantage of Excel’s data entry shortcuts.

• Map data files created by barcode scanners into the inventory
worksheet.

• Save a physical inventory spreadsheet on your PC and work on
it any time.

• Automatically upload the data into Oracle Assets when you are
satisfied with the worksheet.
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Reconcile Inventory Features and Benefits

Because ADI does this..... You can......

Automatically define and
generate personalized
spreadsheet–based physical
inventory worksheets.

Tailor the physical inventory
worksheet to you r data entry re-
quirements – it includes on the
information that you want to en-
ter.

Enables quick physical inventory
entry through spreadsheet Cut,
Copy, and Paste functionality.

Maximize productivity by de-
creasing the necessary keystrokes
to enter data.

Provides Lists of Values for easy
access to valid field information.

Ensure accuracy by eliminating
the need to manually look up val-
id field entries.

Maps data files into physical
inventory worksheets when used
with the Import Text File feature

Take advantage of bar code scan-
ner technology to gather physical
inventory information quickly
and accurately.

Constructs physical inventory
worksheets which can be used
while disconnected from the
database.

Mobilize the asset maintenance
process by automating inventory
data collection at scattered com-
pany locations.

Defines physical inventory layout
templates which can be modified
and reused.

Enter physical inventory by de-
fining an inventory layout once,
then using the layout to build
consistent worksheets whenever
necessary.

Automatically launches the
Physical Inventory Comparison
Program and Report.

Maintains an accurate fixed asset
database by reconciling physical
to system asset inventories and
highlighting differences between
the two.

Building a Physical Inventory Worksheet

To build a physical inventory worksheet, you specify the elements that
you want to use:
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• Physical Inventory: Select the physical inventory for which you
want to run the assets reconciliation. Inventory names are
defined in Oracle Assets. Only open inventories can be chosen.
An inventory is open when it does not have an associated End
Date.

• Layout Template: Layout templates allow you to select the fields
that should be included in the physical inventory worksheet.
They also control the order in which the data fields appear in
your worksheet. Layout templates are saved in the database and
can be edited, viewed, copied, renamed, or created from scratch.

Based on your choices, ADI automatically builds the physical inventory
worksheet.

� To build your physical inventory worksheet:

1. Choose the Assets icon from the ADI toolbar and select Record
Physical Inventory from the poplist.

The Record Physical Inventory window appears.

2. In the Select Inventory field, choose FA Physical–Dec 1997 from the
poplist.

3. Choose the Actions button in the Record Physical Inventory
window. Select New from the poplist.

The Actions button displays tasks that you can perform with
Layout Templates. Layout Templates are saved in the database and
can be reused.

Below is a list of options you may choose using the Actions button:



6 – 20 Oracle Applications Desktop Integrator Tutorial

New: Choose this option to create a new layout template.

View/Edit: Choose this option to view or edit an existing layout
template.

Note:  When you choose this option when the default template
is selected, you have the option only to view the default
template. You cannot edit the default template.

Copy: Choose this option to copy an existing layout template.

Rename: Choose this option to rename an existing layout template.

Note:  You cannot rename the default template.

Delete: Choose this option to delete an existing layout template.

Note:  You cannot delete the default template.

4. For the layout name, type your initials and Inventory Layout.

The Edit Layout window appears. This window shows the list of
available fields that can be included in the asset worksheet. You can
drag and drop fields from the Available Fields region to the Header
and Lines regions to create the layout template. You can also order
the fields by using the directional arrow buttons.

Required fields that must be assigned to either the Header or Lines
regions are marked with a red asterisk. Conditionally required
fields are marked with a green asterisk. You must assign at least
one of the conditionally required fields to either the Header or
Lines region.
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5. Use your mouse to drag and drop the following fields from the
Available Fields region into the Header region.

Location

6. Use your mouse to drag and drop the following fields from the
Available Fields region into the lines region.

Asset Number

Units

Description

7. Choose one of the fields in the Lines region. Use the directional
arrow buttons to re–sequence the fields.

8. Choose OK in the Edit Layout window. Choose OK in the Record
Physical Inventory window.

ADI creates a physical inventory worksheet that reflects your choices.

Your physical inventory worksheet should look similar to the
following:
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Note the following:

• The physical inventory worksheet header and lines regions list
the fields you chose, in the sequence you chose.

Entering Physical Inventory Data

You can enter information into the physical inventory worksheet either
manually or by using the Import Text File feature to map data from a
text file into the worksheet.

Begin by using the Import Text File feature to populate the physical
inventory worksheet with data from an external source.

� To enter data into a physical inventory worksheet:

1. Choose the Assets icon from the ADI toolbar and select Import Text
File from the poplist.

2. In This Field... Select...
Source File OracleHome\GLDI90\INVENTRY.
TXT
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First row contains field names Checked
Delimiter Tab

3. Choose the Actions button in the Import Physical Inventory Text
File window. Select New from the poplist.

4. For the mapping template name, type your initials and Inventory
Map. Choose OK.

The Mapping window appears. This window shows the list of
fields that are in the source text file, and the list of fields that are in
the physical inventory spreadsheet. You can use either the
directional arrow buttons or simply drag and drop fields from the
Import File Fields region to the corresponding field in the Excel
Spreadsheet Fields region.



6 – 24 Oracle Applications Desktop Integrator Tutorial

5. Use your mouse to drag and drop fields from the Import File Fields
region to the corresponding field in the Excel Spreadsheet Fields
region.

6. Choose OK in the Mapping window. Choose OK in the Import
Physical Inventory Text File window.

ADI maps the data from the source file into the physical inventory
worksheet.

Your physical inventory worksheet should look like the following:
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Note the following:

• The data from the source text file has been mapped to fields in
the physical inventory worksheet. The mapping was
accomplished for the fields you chose, in the pairing that you
chose.

• Upload flag is set for every row in the physical inventory
worksheet that was mapped from the source text file.

You’ve entered data into the physical inventory worksheet
automatically by mapping information from a text file. You can also
enter data directly in the spreadsheet, taking advantage of lists of
values and spreadsheet data entry shortcuts.

7. Enter an asset number of 100091, a description of Oak Desk, and
units of 18 on the twentieth worksheet line.

8. Highlight the asset number in the twentieth journal line.

9. Place your mouse on the border of the cell until it turns into a cross.

10. Drag downward to fill the next row.

11. Replace the Description in the new row with PC Multimedia.
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Now that you have physical inventory data in your spreadsheet, we
will upload this information to Oracle Assets.

Uploading Physical Inventory Entries

Follow the steps below to upload physical inventory data to Oracle
Assets.

� To upload physical inventory entries to Oracle Assets:

1. Choose the Assets icon from the ADI toolbar and select Upload to
Interface from the poplist.

The Upload Physical Inventory to Interface window appears.

2. For the Rows to Upload option, choose All Rows.

3. For the Duplicate Assets option, choose Replace Units.

4. Check the Run Comparison option.

5. Check the View Results option.

6. Choose OK to start the upload.

ADI uploads your rows to the Oracle Assets physical inventory
interface table. It then starts two concurrent processes – the
physical inventory comparison program and the physical inventory
comparison report. Both of these processes run on the server.
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The comparison program attempts to match each asset in the
physical inventory table to an asset in the production system. The
comparison report then shows the results of the comparison
program.

ADI displays a message that looks similar to the following:

The message informs you that the physical inventory comparison
program and report concurrent processes have started. It runs in
the background, so you can continue using ADI while the processes
complete. The Request Center notifies you when the processes
complete by blinking at the bottom of your screen, and by playing
sound if your PC can play sound files.

7. Notice that the Messages column in the physical inventory
worksheet displays a green success indicator in each row that was
uploaded. To enable this feature, go the ADI toolbar and select the
Options icon. Choose the Settings tab in the window that appears.
Be sure that the Show Upload Success check box is marked.

During upload, ADI validates your accounts and reference fields,
such as Category and Location. If you entered invalid values for
any of these fields, ADI displays an error message when you
upload. For example, if you entered an invalid location, you will
see the following:

In this case, you can use the list of values to choose a valid location,
and then upload again.
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Viewing the Physical Inventory Comparison Results

After the Request Center notifies you that the physical inventory
comparison process is complete, you can view the results of the
comparison program. There are two ways to do this:

• Physical Inventory Comparison window

• Physical Inventory Comparison Report

Using the Physical Inventory Comparison Window:

1. Start Oracle Assets

2. Navigate to the Find Physical Inventory Comparison window
(Physical Inventory > Comparison > View).

3. Enter the name of the physical inventory to view the results for the
entire physical inventory. If you want to narrow the search criteria,
you can enter additional parameters, such as category or location.

4. Choose Find.

Using the Physical Inventory Comparison Report:

1. Start the Request Center.

2. Select the report from the Completed tab.

3. Choose the Publish Output button from the Request Center toolbar.

4. Select the Output Type of Text.

5. In the Publish To field of the Text Options region, type a valid path
and file name: for example: C:\temp\XXcompare.txt, where XX is
your initials.

6. Choose OK to publish the report.
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Report Manager Kiosk

This chapter contains lessons that explain how to perform the following
tasks:

• Publish reports to the database using the Request Center

• Define Security Access models

• Manage your Report Manager documents and files

• Customize the Report Manager to your specific needs

• Access database reports from the Report Manager kiosk.
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Report Manager

Earlier in this tutorial, you learned how to use the Request Center to
submit, monitor, and publish reports. In this chapter, you will learn
how to publish reports into the database and view them using a
standard browser.

Overview

By using the Request Center to publish reports to a web page, you
utilize the efficient internet framework for report dissemination,
drastically reducing the costs associated with traditional paper report
distribution.

Report Manager is a natural extension to this publish, subscribe, and
pull–on–demand report distribution model. The Report Manager has
two powerful features:

• The Request Center allows you to publish reports directly into
the database.

• The Report Manager Kiosk allows you to access database reports
using a standard web browser.

With Report Manager, you can create point–in–time document libraries
which are 100% pure internet, 100% pure database. This means that
your information is stored in an environment which is secure yet
readily available to authorized users.

Key Benefits

• Secured Access to Reports

Report Manager leverages the same user and responsibility
framework already in place within the standard application.
Report producers can be confident that only authorized
personnel can view report contents. Report security is managed
at the core database level as opposed to the web server level.

• Self–Service Access to Reports

Report Manager offers a centralized kiosk for report
information. Authorized users can easily access the reports via
a standard browser. In addition, Report Manager is fully
compatible with Oracle Self–Service web applications and
Business Intelligence System (BIS). Users will be able to access
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Self–Service functions and BIS reports, along with Request
Center output, from a web browser.

• Support for Point–in–Time Reports

Report Manager output is stored in the database and is a static
representation of point–in–time information. Point–in–time
reports such as year–end financial statements are stored in a
stable repository and are easily available for user reference.
Users do not have to run these reports just to view the
information – the information is already in the database.

Because Report Manager does
this... You can...

Provides a centralized source for
point in time reports

Access business information
from a central site using a
standard browser.

Organizes reports using a
hierarchical tree structure that
corresponds to user
responsibilities

Enjoy quick and intuitive access
to reports. The hierarchical tree
structure can be expanded or
collapsed, lending itself to rapid
report mining.

Supports general public access to
reports

Make documents such as the
Company Annual Report
available to everyone in the
organization via the internet.

Secures access to reports,
requiring user to sign on before
granting admittance

Ensure that confidential reports
are completely protected against
unauthorized access.

Allows reports to be previewed
by designated users before
general release

Verify report appearance and
placement before the report is
made available to the end
audience.

Kiosk can be customized to
include the company logo as well
as default home pages for the
public and secured access menus
respectively

Reflect your company culture
and values within the Kiosk,
contributing to the creation of a
”sticky” site.
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You can...
Because Report Manager does
this...

Provides pop lists for expansion
values and timeframes

Quickly view multiple versions
of the same report based upon
varying expansion values and
timeframes. This facilitates data
comparison and trend detection.

Attaches spreadsheets or text
files to reports

Download spreadsheet or text
versions of the report for further
analysis.

Uploads all file types into the
database

Store files in the database,
simultaneously allowing
universal access and controlled
management.

Performs upload validation to
detect if duplicate files exist in
the database

Promote efficient usage of
database resources and detect
possible file integrity breaches.

Publishing a Report to the Database

The Request Center is an enterprise report management tool that
allows you to submit, monitor, and publish all reports from Oracle
Applications. By publishing reports into the database, you can create
point–in–time document libraries that can be quickly accessed using
any web browser.

In the following lesson, you submit a financial report, publish it to the
database, view the report from the database using a browser, and
download a spreadsheet version of the report from the database.
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� To Publish a Report to the Database:

1. Choose the Submit Report button on the Request Center toolbar.

The Report Submission and Publishing window appears.

2. You can choose to submit any Report Type for publishing into the
database.

3. In the Report Type field, select Financial Statement.

4. Select the Existing Report Field, and type Statement of Cash Flows.

5. In the Period field, select Mar–97.

6. Leave the defaults in the other fields, and choose the Publishing
button.

7. For the Output Type, choose Database Web Page.

8. In the Database Web Page Options region, choose the Find button
next to the Publish To text box.

The Publish To window appears. This window is used to specify
where your report should be placed. It controls how the report will
be located by your audience when they navigate to the Report
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Manager Kiosk, Oracle Self–Service Web Applications home page,
or the BIS home page.

9. Select Public as the Menu Type.

10. Highlight the folder, Public Reports.

11. Select the Add Menu Entry icon. The Add Menu Entry window
appears. Note that Statement of Cash Flows defaults as the title.

12. Select the OK button. The Add Menu Entry window closes, and
you are returned to the Publish To window.

Note:  Note that a new menu entry has been created with the
title Statement of Cash Flows. This is where the report will be
placed when it is being viewed from the Report Manager
Kiosk.

13. Select the OK button. The Publish To window closes, and you are
returned to the Report Submission and Publishing window.

Note:  The Publish To text box has been updated with Public
Reports\Statement of Cash Flows.

14. In the Database Web Page Options region, choose the Find button
next to the Timeframe text box.

The Timeframe List of Values window appears. This window
displays all of the accounting periods created in the General Ledger
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standard applications. You can use the Timeframe to distinguish
between different versions of the same report. This is especially
handy during the period close cycle when you are generating
successive draft versions of the report before finalizing your
results. For example, you could distinguish each report version
with the Timeframes Interim 1, Interim 2, and Final.

15. Choose the Cancel button.

16. The Timeframe defaults to Mar–97, the period for which you are
submitting the report.

Your screen should look like the following:

17. Choose OK to submit the report.

18. Choose the Pending tab in the Request Center.

Your request is listed. When the request is complete, a message
window appears confirming the success of the request submission.
The request then appears on the completed tab.

� To View a Report Published To the Database:

1. Launch your web browser.
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2. Navigate to the Report Manager Kiosk.

3. From the Kiosk navigation frame, double–click on the Statement of
Cash Flows. Your window should look similar to the following
example:

4. When you defined your Publishing options, you elected to include
a spreadsheet with your Web Page output. Notice the Excel icon in
the upper left corner of the content frame. Choose this icon to
download the Statement of Cash Flows report to Excel.

The report downloads and opens as an Excel worksheet.

� To Create Point In Time Report Libraries

1. Choose the Submit Report button from the Request Center toolbar.

The Report Submission and Publishing window appears.

2. You can choose to submit any Report Type for publishing into the
database.

3. In the Report Type field, select Financial Statement.

4. Select the Existing Report Field, and type Statement of Cash Flows.

5. In the Period field, select Apr–97.
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6. Leave the defaults in the other fields, and choose the Publishing
button.

7. For the Output Type, choose Database Web Page.

Note that the Publish To text box in the Database Web Page
Options region is automatically set to the last Menu used for this
report: Public Reports\Statement of Cash Flows.

8. Your screen should look like the following:

9. Choose OK to submit the report.

10. Choose the Pending tab in the Request Center.

11. When the report request has completed, navigate to the Report
Manager Kiosk and select the Statement of Cash Flows report. You
now have two versions of the report: one for the Mar–97 timeframe
and one for the Apr–97 timeframe.
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Security and Preview Options

When you publish reports to the database, you can choose to make
these reports available to the public or available only to authorized
personnel.

In the previous lesson you learned how to publish a report into the
database and how to view it using a standard browser. The report was
published into a public access menu and was available to all users.

In this lesson, you will learn how to restrict access to a report so that
only authorized users can view it. You will also learn how to delay a
report’s availability until a future date, and how to grant preview
privileges to select users.

� To Publish A Secured Report To the Database:

1. Choose the Submit Report button from the Request Center toolbar.

The Report Submission and Publishing window appears.

2. In the Report Type field, select Financial Statement.
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3. Select the Existing Report Field, and type Summary Income
Statement.

4. In the Period field, select Mar–97.

5. Leave the defaults in the other fields, and choose the Publishing
button. Note that this report is submitted with a Sales Department
Content Set.

6. For the Output Type, choose Database Web Page.

7. In the Database Web Page Options region, choose the Find button
next to the Publish To text box.

The Publish To window appears.

8. Select Secured as the Menu Type.

9. Expand the Operations folder.

10. Choose the Add Folder button.

The Add Folder window appears.

11. Enter the title, Financial Reports, and choose OK.

The Access For Financial Reports window appears. This window
allows you to grant access to responsibility level Folders to other
users.
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12. Choose the user PJONES from the list. Choose OK.

13. In the Publish To window, double click the newly created Financial
Reports folder to open.

14. Select the Insert Menu Entry icon. The Add Menu Entry window
appears. Note that Summary Income Statement is the listed entry.

15. Select the OK button. The Add Menu Entry window closes, and
you are returned to the Publish To.

Note that a new menu entry has been created with the Title,
Summary Income Statement. This is where the report will be
placed when it is being viewed.

16. Select the OK button. The Publish To window closes, and you are
returned to the Report Submission and Publishing window.

Note:  The Publish To text box has been updated with
Operations\Financial Reports\Summary Income Statement.

17. Select the Find button next to the Availablilty text box.

The Availablity window appears. You can choose to make the
report available immediately, at an indefinite time in the future, or
at a specific date and time.

18. Choose the On Hold option to make the report available at an
indefinite time in the future.

19. Choose OK. The Availability window closes, and you are returned
to the Report Submission and Publishing window.

Note:  The Availability text box has been updated to On Hold.

20. The Previewer text box has also been set to the user operations. You
can grant report preview privileges to more users by selecting the
Find button next to the Previewer text box.

Your screen should look like the following example.
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21. Choose OK to submit the report.

22. Choose the Pending tab in the Request Center.

23. Note that your request is listed. When the request is complete, a
message appears confirming the success of the request submission.
The request then appears on the completed tab.

� To Preview a Report:

1. Launch your web browser.

2. Navigate to the Report Manager.

3. Choose the Signon button at the bottom of the Kiosk navigation
frame.

The Report Manager Signon page is displayed.

4. Enter the your user name and password, PJONES\Welcome to sign
on.

The navigation frame is updated to show all the reports and
functions for your security setting.

5. Expand the Finanical Reports folder and select the Summary
Income Statement.

Your screen should look similar to the following:
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6. In the previous exercise, the Summary Income Statement was
published with an Availability of On Hold. As such, authorized
users who would normally have access to the Summary Income
Statement are barred from viewing the report until it is released.

7. Select the Logout button at the bottom of the Kiosk navigation
frame.

The Report Manager Kiosk home page is displayed.
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8. Select the Signon button at the bottom of the Kiosk navigation
frame. The Report Manager Kiosk Signon page is displayed.

The navigation frame is updated to show all the reports and
functions for your security setting.

9. Enter the Username and password, Operations\Welcome.

10. Expand the Financial Reports folder and select the Summary
Income Statement.

Your screen should look similar to the following:

11. You have signed on as a designated Previewer of the Summary
Income Statement. You are allowed to preview the report and
decide when the report should become available to other
authorized users.

12. Select the Make Available: Now check box.

The following message appears to confirm your decision:

Note:  When you release one of the report outputs under
preview status, all of the report outputs under preview status
for the specific timeframe are released.

13. Choose OK. The Summary Income Statement for Mar–97
timeframe is now available to all authorized users.
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14. Select the Signon button at the bottom of the Kiosk navigation
frame.

The Report Manager Signon page is displayed.

15. Enter the user name and password. PJONES\Welcome.

The navigation frame is updated to show all the reports and
functions for your security setting.

16. Select the Summary Income Statement report from the navigation
tree.

Note:  You can now view the report with this user name and
password.

Uploading Files to the Database

In addition to reports, you can use the Request Center to upload other
files directly into the database. You can upload files ranging from a web
page to a word document.

In this lesson, you will learn how to upload a graphics file and use it as
the company logo for the Report Manager. You will also learn how to
upload a web page which will be used as the Kiosk home page.

� Uploading Your Company Logo:

1. Choose the Report Manager Tools button from the Request Center
toolbar.

The Report Manager window appears.

2. Choose the Upload Files button from the Report Manager window.

3. In the Select Files region, choose the Find button and select
any image file (gif, Jpeg, or Jpeg file) as the file to be uploaded.

4. Notice the file usage options at the bottom of the window. Enable
the Kiosk Logo check box.

5. Choose OK.

Your image file will be uploaded to the database.
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� Uploading the Kiosk Home Page:

1. Choose the Report Manager Tools button from the Request Center
toolbar.

2. Choose the Upload button.

The Upload to Database window appears.

3. In the Files region, choose the Find button and select any web page
(htm or html file) as the file to be uploaded.

4. Notice the file usage options at the bottom of the window. Enable
both the Kiosk Public Home Page and the Kiosk Secured Home
Page check boxes.

5. Choose OK to save your work.

� Viewing Your Uploaded Files:

1. Launch your web browser.

2. Navigate to the Report Manager Kiosk.

3. Notice that the logo in the Kiosk Navigation frame displays your
chosen logo.

4. Notice that the home page in the Kiosk content frame displays your
selected web page.
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File Maintenance

Additional Report Manager tools help you manage reports and files
which have been uploaded into the database. You can adjust the
placement of entries in the menu structure, add new entries, or delete
them.

In this lesson, you will learn how to create a new folder and add a new
menu entry. You will also learn how to move a menu entry up and
down the tree structure.

� Adding a New Folder:

1. Choose the Report Manager Tools button from the Request Center
toolbar.

The Report Manager window appears.

2. Choose the Organize Folders button from the Report Manager
window.

The Organize Folders window appears.

3. Choose the Secured Menu Type and expand the Operations folder.
Select the Add Folder button.

The Add Folder window appears.

4. Enter the new title, Web Pages, in the Title text box and select the
New radio button. You can choose existing titles from a list of
values in the Existing Title text box and selecting the Existing radio
button.

5. Choose OK to create the new folder.

The Add Folder window closes and the Access window appears.



7 – 19Web Reporting Kiosk

6. You can assign access based upon responsibility to this folder. For
now, do not select any of the choices from the list and close the
window.

You are brought back to the Publish To window. Note that you
have created a new folder called Web Pages.

7. Select the Operation folder and select the Add Folder button.

8. Select the New button from the Type region, and enter Statutory
Reports in the Title text box.

9. Choose OK to create the new folder. Close the Access window.

You have created two new folders: Web Pages and Statutory
Reports.

� Adding a New Menu Entry:

1. Choose the Report Manager Tools button from the Request Center
toolbar.

The Report Manager window appears.

2. Choose the Organize Folders button form the Report Manager
window.

The Organize Folders window appears.

3. Expand the Statutory Reports folder and select the Add Menu
Entry button from the Menu Editor window.

The Add Menu Entry window appears.

4. Enter Oracle Home in the Title text box.
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5. Select the Web Address radio button from the Type region. Enter
http://www.oracle.com in the URL text box.

6. Choose OK to create the new menu entry.

The Add Menu Entry window closes and you are brought back to
the Organize Folders. Note that you have created a new menu
entry for Oracle Home in the Statutory Reports folder.

7. Choose OK to save the change you made to the menu structure.

� Moving Menu Entries

1. Choose the Report Manager Tools button from the Request Center
toolbar.

The Report Manager window appears.

2. Choose the Organize Folders button from the Report Manager
window.

The Organize Folders window appears.

3. Expand the Web Pages folder by double clicking in it.

4. Expand the Statutory Reports folder and select the Oracle Home
menu entry. Select the Move Down button. The Oracle Home menu
entry moves down into the Web Pages folder.
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5. Choose OK to save the changes you made.

� Viewing Menu Changes:

1. Launch your web browser.

2. Navigate to the Report Manager Kiosk. Sign on as
Operations\Welcome. Your screen should look similar to the
following.

3. Notice that the Kiosk navigation frame reflects the changes you’ve
made through the Organize Folders window.
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Glossary – 1

Glossary

account hierarchy  An Oracle Applications
feature you use to perform summary level
funds checking.  An account hierarchy lets
Oracle Purchasing and Oracle Order Entry
quickly determine the summary accounts
into which your detail accounts roll up.

Account segment  One of up to 30 different
sections of your Accounting Flexfield,
which together make up your general
ledger account code.  Each segment is
separated from the other segments by a
symbol you choose (such as –, /, or \).
Each segment typically represents an
element of your business structure, such as
Company, Cost Center or Account. 

Account segment value  A series of characters
and a description that define a unique
value for a particular value set.

account structure  See Accounting Flexfield
structure.

accounting calendar  The calendar that defines
your accounting periods and fiscal years in
Oracle General Ledger.  You define
accounting calendars using the Accounting
Calendar window.  Oracle Financial
Analyzer will automatically create a Time
dimension using your accounting calendar.

Accounting Flexfield  The code you use to
identify a general ledger account in an
Oracle Applications application.  Each
Accounting Flexfield segment value
corresponds to a summary or rollup
account within your chart of accounts.

Accounting Flexfield structure  The account
structure you define to fit the specific needs
of your organization.  You choose the
number of segments, as well as the length,
name, and order of each segment in your
Accounting Flexfield structure.

Accounting Flexfield value set  A group of
values and attributes of the values.  For
example, the value length and value type
that you assign to your account segment to
identify a particular element of your
business, such as Company, Division,
Region, or Product.

ad hoc  Concerned with or formed for a
particular purpose.  For example, ad hoc
tax codes or an ad hoc database query.



Glossary – 2 Oracle Applications Desktop Integrator Tutorial

aggregate balance  The sum of the end–of–day
balances for a range of days.  There are
three types of aggregate balances:
period–to–date (PTD), quarter–to–date
(QTD), and year–to–date (YTD).  All three
are stored in the General Ledger database
for every calendar day.

allocation entry  A recurring journal entry you
use to allocate revenues or costs.

archive table  Oracle Order Entry copies your
account balances from the Balances Table
(GL_BALANCES) to your Archive Table
(GL_ARCHIVE_BALANCES).  Oracle
Order Entry copies your journal details
from the Journal Entry tables
(GL_JE_BATCHES, GL_JE_HEADERS, and
GL_JE_LINES) to your archive tables
(GL_ARCHIVE_BATCHES,
GL_ARCHIVE_HEADERS, and
GL_ARCHIVE_LINES).

archive tablespace  The tablespace where your
archive table is stored.  A tablespace is the
area in which an Oracle7 database is
divided to hold tables.

attribute  An Oracle Financial Analyzer
database object that links or relates the
values of two dimensions.  For example,
you might define an attribute that relates
the Sales District dimension to the Region
dimension so that you can select data for
sales districts according to region.

AutoCopy – budget organizations  A feature
that automatically creates a new budget
organization by copying account
assignments from an existing budget
organization.

AutoCopy – budgets  A feature that
automatically creates a new budget by
copying all of the data from an existing
budget.  Budget AutoCopy copies budget
amounts only from open budget years.

AutoOffset  A feature that automatically
determines the offset (or credit) entry for
your allocation entry.  AutoOffset
automatically calculates the net of all
previous journal lines in your allocation
entry, reverses the sign, and generates the
contra amount.

AutoReduction  An Oracle Applications
feature in the list window that allows you
to shorten a list so that you must scan only
a subset of values before choosing a final
value.  Just as AutoReduction incrementally
reduces a list of values as you enter
additional character(s), pressing
[Backspace] incrementally expands a list.

AutoSelection  A feature in the list window
that allows you to choose a valid value
from the list with a single keystroke.  When
you display the list window, you can type
the first character of the choice you want in
the window.  If only one choice begins with
the character you enter, AutoSelection
selects the choice, closes the list window,
and enters the value in the appropriate
field.
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AutoSkip  A feature specific to flexfields
where Oracle Applications automatically
moves your cursor to the next segment as
soon as you enter a valid value into a
current flexfield segment.  You can turn this
feature on or off with the user profile
option Flexfields:AutoSkip.

average balance  The amount computed by
dividing an aggregate balance by the
number of calendar days in the related
range.

average exchange rate  An exchange rate that
is the average rate for an entire accounting
period.  General Ledger automatically
translates revenue and expense account
balances using period–average rates in
accordance with FASB 52 (U.S.).  And, for
companies in highly inflationary
economies, General Ledger uses average
exchange rates to translate your
non–historical revenue and expense
accounts in accordance with FASB 8  (U.S.).
Also known as period–average exchange
rate. 

back–value transactions  Transactions whose
effective date is prior to the current
accounting date.  Also known as value–dated
transactions.

balances table  A General Ledger database
table that stores your account balances,
called GL_BALANCES.

balancing segment  An Accounting Flexfield
segment that you define so that General
Ledger automatically balances all journal
entries for each value of this segment.  For
example, if your company segment is a
balancing segment, General Ledger ensures
that, within every journal entry, the total
debits to company 01 equal the total credits
to company 01.  

bank statement  A report sent from a bank to a
customer showing all transaction activity
for a bank account for a specific period of
time.  Bank statements report beginning
balance, deposits made, checks cleared,
bank charges, credits, and ending balance.
Enclosed with the bank statement are
cancelled checks, debit memos, and credit
memos.  Large institutional banking
customers usually receive electronic bank
statements as well as the paper versions.

budget  Estimated cost, revenue, labor hours
or other quantities for a project or task.
Each budget may optionally be categorized
by resource.  Different budget types may be
set up to classify budgets for different
purposes.  In addition, different versions
can exist for each user–defined budget
type: current, original, revised original, and
historical versions.  The current version of a
budget is the most recently baselined
version.  .

budget formula  A mathematical expression
used to calculate budget amounts based on
actual results, other budget amounts and
statistics.  With budget formulas, you can
automatically create budgets using complex
equations, calculations and allocations.

budget hierarchy  A group of budgets linked
at different levels such that the budgeting
authority of a lower–level budget is
controlled by an upper–level budget.

budget interface table  An Oracle General
Ledger database table that stores
information needed for budget upload.
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budget organization  An entity (department,
cost center, division or other group)
responsible for entering and maintaining
budget data.  You define budget
organizations for your company, then
assign the appropriate accounts to each
budget organization. 

budget rules  A variety of shorthand
techniques you can use to speed manual
budget entry.  With budget rules you can
divide a total amount evenly among budget
periods, repeat a given amount in each
budget period or enter budget amounts
derived from your account balances.

budget upload  The ability to transfer budget
information from a spreadsheet to Oracle
Order Entry.  For example, with the
spreadsheet interface you can upload
budget information from your spreadsheet
to Oracle Order Entry.

budgetary account  An account segment value
(such as 6110) that is assigned one of the
two budgetary account types.  You use
budgetary accounts to record the
movement of funds through the budget
process from appropriation to expended
appropriation.

Budgetary Account  An account that contains
a budgetary account.

budgetary account type  Either of the two
account types Budgetary DR and
Budgetary CR.

budgetary control  An Oracle Applications
feature you use to control actual and
anticipated expenditures against a budget.
When budgetary control is enabled, you
can check funds online for transactions, and
you can reserve funds for transactions by
creating encumbrances.  Oracle
Applications automatically calculates funds
available (budget less encumbrances less
actual expenditures) when you attempt to
reserve funds for a transaction.  Oracle
Applications notifies you online if funds
available are insufficient for your
transaction.

business day  Days on which financial
institutions conduct business.  In General
Ledger, you choose which days of the
calendar year are defined as business days.
You can include or exclude weekends and
holidays as needed.

business group  The highest level of
organization and the largest grouping of
employees across which a company can
report.  A business group can correspond to
an entire company, or to a specific division
within the company.  

child segment value  A detail–level segment
value that is part of a parent segment value.
See also parent segment value.

chart of accounts  The account structure your
organization uses to record transactions
and maintain account balances.
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chart of accounts structure  A classification of
account segment values that assigns a
particular range of values a common
characteristic.  For example, 1000 to 1999
might be the range of segment values for
assets in the account segment of your
accounting flexfield.

column set  A Financial Statement Generator
report component you build within Oracle
Order Entry by defining all of the columns
in a report.  You control the format and
content of each column, including column
headings, spacing and size, calculations,
units of measure, and precision.  A typical
column set includes a header column for
headings and subheadings, currency
assignments, amount types, and calculation
columns totals.  You can also define a
column set with each column representing a
different company to enhance consolidation
reporting. 

commitment   An encumbrance you record
when you complete a purchase requisition.

concurrent manager  A unique facility that
manages many time–consuming,
non–interactive tasks within Oracle
Applications for you, so you do not have to
wait for their completion.  When you
submit a request in Oracle Applications
that does not require your interaction, such
as releasing shipments or running a report,
the Concurrent Manager does the work for
you, enabling you to complete multiple
tasks simultaneously.

concurrent process  A non–interactive task
that you request Oracle Applications to
complete.  Each time you submit a
non–interactive task, you create a new
concurrent process.  A concurrent process
runs simultaneously with other concurrent
processes (and other interactive activities
on your computer) to help you complete
multiple tasks at once.

concurrent queue  A list of concurrent
requests awaiting completion by a
concurrent manager.  Each concurrent
manager has a queue of requests waiting to
be run.  If your system administrator sets
up your Oracle Application to have
simultaneous queuing, your request can
wait to run in more than one queue.

concurrent request  A request to Oracle
Applications to complete a non–interactive
task for you.  You issue a request whenever
you submit a non–interactive task, such as
releasing a shipment, posting a journal
entry, or running a report.  Once you
submit a request, Oracle Applications
automatically takes over for you,
completing your request without further
involvement from you or interruption of
your work.
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consolidation  A General Ledger feature that
allows you to combine the results of
multiple companies, even if they are in
different sets of books with different
currencies, calendars, and charts of
account.  The Consolidated Billing Invoice
program lets you print a single, monthly
invoice that includes all of your customer’s
transactions for the period.  This lets you
send one consolidated billing invoice
instead of a separate invoice for each
transaction.

consolidation set of books  A set of books that
has average balance processing enabled and
that is defined as a consolidation set of
books.  A consolidation set of books must
be used to consolidate average balances
using the balances consolidation method.

consumption tax  An indirect tax imposed on
transfer of goods and services at each stage
of their supply.  The difference between
output tax (tax collected for revenue earned
from the transfer) and the input tax (tax
paid on expense paid on the transfer) will
be the tax liability to the government.  This
tax is, in concept, value added tax (VAT).

content set  A report component you build
within General Ledger that defines the
information in each report and the printing
sequence of your reports.  For example, you
can define a departmental content set that
prints one report for each department.

context field prompt  A question or prompt to
which a user enters a response, called a
context field value.  When Oracle
Applications displays a descriptive flexfield
pop–up window, it displays your context
field prompt after it displays any global
segments you have defined.  Each
descriptive flexfield can have up to one
context prompt.

context field value  A response to your context
field prompt.  Your response is composed
of a series of characters and a description.
The response and description together
provide a unique value for your context
prompt, such as 1500, Journal Batch ID, or
2000, Budget Formula Batch ID.  The
context field value determines which
additional descriptive flexfield segments
appear.

context response  See context field value.

context segment value  A response to your
context–sensitive segment.  The response is
composed of a series of characters and a
description.  The response and description
together provide a unique value for your
context–sensitive segment, such as
Redwood Shores, Oracle Corporation
Headquarters, or Minneapolis, Merrill
Aviation’s Hub.

context–sensitive segment  A descriptive
flexfield segment that appears in a second
pop–up window when you enter a response
to your context field prompt.  For each
context response, you can define multiple
context segments, and you control the
sequence of the context segments in the
second pop–up window.  Each
context–sensitive segment typically
prompts you for one item of information
related to your context response.

conversion  A process that converts foreign
currency transactions to your functional
currency.  See also foreign currency
conversion.
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corporate exchange rate  An exchange rate you
can optionally use to perform foreign
currency conversion.  The corporate
exchange rate is usually a standard market
rate determined by senior financial
management for use throughout the
organization.  You define this rate in Oracle
General Ledger.

cross–validation rules  Rules that define valid
combinations of segment values a user can
enter in an account.  Cross–validation rules
restrict users from entering invalid
combinations of account segment values.

Cumulative Translation Adjustment  A
balance sheet account included in
stockholder’s equity in which Oracle Order
Entry records net translation adjustments in
accordance with FASB 52 (U.S.).  You
specify the account you want to use for
Cumulative Translation Adjustment when
you define each set of books in the Set of
Books window.

current dimension  The Oracle Financial
Analyzer dimension from which you are
selecting values.  The current dimension is
the one you specified in the Dimension box
of the Selector window.  Choices you make
and actions you take in lower–level
windows ultimately affect this dimension
by selecting values from it to include in a
report, graph, or worksheet.

current object  The Oracle Financial Analyzer
object upon which the next specified action
takes place.  Generally, the current object is
the one most recently selected.  However, if
you use a highlight a group of objects, such
as data cells in a column, the first object in
the group is the current object.

DBA library  If an Oracle Financial Analyzer
database object belongs to a DBA library, it
means that the object was created by an
administrator and cannot be modified by a
user.

database table  A basic data storage structure
in a relational database management
system.  A table consists of one or more
units of information (rows), each of which
contains the same kind of values (columns).
Your application’s programs and windows
access the information in the tables for you.

dependent segment  An account segment in
which the available values depend on
values entered in a previous segment,
called the independent segment.  For
example, the dependent segment
Sub–Account 0001 might mean Bank of
Alaska when combined with the
independent segment Account 1100, Cash,
but the same Sub–Account 0001 might
mean Building #3 when combined with
Account 1700, Fixed Assets.

descriptive flexfield   A field that your
organization can extend to capture extra
information not otherwise tracked by
Oracle Applications.  A descriptive flexfield
appears in your window as a single
character, unnamed field.  Your
organization can customize this field to
capture additional information unique to
your business.

detail budget  A budget whose authority is
controlled by another budget.
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dimension  An Oracle Financial Analyzer
database object used to organize and index
the data stored in a variable.  Dimensions
answer the following questions about data:
”What?” ”When?” and ”Where?”  For
example, a variable called Units Sold might
be associated with the dimensions Product,
Month, and District.  In this case, Units
Sold describes the number of products sold
during specific months within specific
districts.

dimension label  A text label that displays the
name of the Oracle Financial Analyzer
dimension associated with an element of a
report, graph, or worksheet.  For example,
the data markers in a graph’s legend
contain dimension labels that show what
data each data marker represents.
Dimension labels can be short, meaning
they display the object name of a
dimension, or user–specified, meaning they
display a label that you typed using the
Dimension Labels option on the Graph,
Report, or Worksheet menus.

dimension values  Elements that make up an
Oracle Financial Analyzer dimension.  For
example, the dimension values of the
Product dimension might include Tents,
Canoes, Racquets, and Sportswear.

display group  A range of rows or columns in
your row set or column set for which you
want to control the display in your report.
You assign a display group to a display set
where you specify whether you want to
display or hide your rows or columns.

display set  A Financial Statement Generator
report component you build within Oracle
Order Entry to control the display of ranges
of rows and columns in a report, without
reformatting the report or losing header
information.  You can define a display set
that works for reports with specific row
and column sets.  Alternatively, you can
define a generic display set that works for
any report.

document sequence number  A number that
is manually or automatically assigned to
your documents to provide an audit trail.
For example, you can choose to
sequentially number invoices in Oracle
Receivables or journal entries in General
Ledger.  See also voucher number.

dynamic insertion  An Accounting Flexfields
feature that allows you to enter and define
new combinations of segment values
directly in a flexfield pop–up window.  The
new combination must satisfy any
cross–validation rules before it is accepted.
Your organization can decide if an
Accounting Flexfield supports dynamic
insertion.  If an account does not support
dynamic insertion, you can only enter new
combinations of segment values using the
Define Accounts window

effective date  The date a transaction affects
the balances in the general ledger.  This
does not have to be the same as the posting
date.  Also known as the value date.

encumbrance  See encumbrance journal entry.
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encumbrance accounting  An Oracle
Financials feature you use to create
encumbrances automatically for
requisitions, purchase orders, and invoices.
The budgetary control feature uses
encumbrance accounting to reserve funds
for budgets.  If you enable encumbrance
accounting only, you can create
encumbrances automatically or manually;
however, you cannot check funds online
and Oracle Financials does not verify
available funds for your transaction.  See
also budgetary control.

encumbrance journal entry  A journal entry
you create online that increases or relieves
your encumbrances.  Encumbrance entries
can include encumbrances of any type.  You
can enter manual encumbrance entries,
define encumbrance allocations, or use
Journal Import to import encumbrance
entries from other financial systems. 

encumbrance type  An encumbrance category
that allows you to track your anticipated
expenditures according to your purchase
approval process and to more accurately
control your planned expenditures.
Examples of encumbrance types are
commitments (requisition encumbrances)
and obligations (purchase order
encumbrances). 

end–of–day balance  The actual balance of a
general ledger account at the end of a day.
This balance includes all transactions
whose effective date precedes or is the
same as the calendar day.

exchange rate  A rate that represents the
amount of one currency that you can
exchange for another at a particular point in
time.  Oracle Applications use the daily,
periodic, and historical exchange rates you
maintain to perform foreign currency
conversion, revaluation, and translation.

exchange rate type  A specification of the
source of an exchange rate.  For example, a
user exchange rate or a corporate exchange
rate.  See also corporate exchange rate, spot
exchange rate.

export  A utility that enables you to copy data
from an Oracle7 table to a file in your
current directory.  The export utility is part
of the Oracle7 Relational Database
Management System.

export file  The file the export utility creates in
your directory.  Export files must have the
extension .dmp.  It is wise to name the
export file so it identifies the data in the
table.  For example, if you are saving fiscal
year 1994 for your Fremont set of books,
you might call your export file
FY94FR.dmp.

factor  Data upon which you perform some
mathematical operation.  Fixed amounts,
statistical account balances, account
balances, and report rows and columns are
all data types you can use in formulas.

FASB 52 (U.S.)  See SFAS 52.

FASB 8 (U.S.)  See SFAS 8.

feeder program  A custom program you write
to transfer your transaction information
from an original system into Oracle
Application interface tables.  The type of
feeder program you write depends on the
environment from which you are importing
data.
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financial data item  An Oracle Financial
Analyzer database object that is made up of
either a variable, or a variable and a
formula.  For example, a financial data item
called ”Actuals” would be a variable, while
a financial data item called ”Actuals
Variance” would be made up of a variable
(Actuals) and a formula that calculates a
variance.

Financial Statement Generator  A powerful
and flexible tool you can use to build your
own custom reports without programming.
You can define reports online with
complete control over the rows, columns
and contents of your report.

fiscal year  Any yearly accounting period
without regard to its relationship to a
calendar year. 

fixed rate currencies  Currencies with fixed
exchange rates.  For example, the Euro and
currencies of countries in the European
Monetary Union (EMU).

FlexBudgeting  A feature that uses budget
formulas and statistics to create a flexible
budget.  For example, a manufacturing
organization may want to maintain a
flexible budget based on actual units of
production to eliminate volume variances
during an analysis of actual versus
budgeted operating results.

flexfield  An Oracle Applications field made
up of segments.  Each segment has an
assigned name and a set of valid values.
Oracle Applications uses flexfields to
capture information about your
organization.  There are two types of
flexfields: key flexfields and descriptive
flexfields.

folder  A flexible entry and display window in
which you can choose the fields you want
to see and where each appears in the
window.

foreign currency  A currency that you define
for your set of books for recording and
conducting accounting transactions in a
currency other than your functional
currency.    See also exchange rate, functional
currency.

foreign currency conversion  A process that
converts a foreign currency journal entry
into your functional currency.  Oracle Order
Entry automatically converts currency
whenever you enter a journal entry in a
currency other than your functional
currency.  Oracle Order Entry multiplies the
daily exchange rate you define or the
exchange rate you enter to convert amounts
for your functional currency.  You can view
the results of foreign currency conversion in
the Enter Journals window.  See also foreign
exchange gain or loss.

foreign currency exchange gain or loss  The
difference in your functional currency
between the invoiced amount and the
payment amount when applying a receipt
to an invoice.  A realized gain exists if the
receipt amount in your functional currency
exceeds the invoice amount; a loss exists if
the invoice amount in your functional
currency exceeds the amount of the
payment.  Such gains and losses arise from
fluctuations in exchange rates of the receipt
currency between the invoice date and the
payment date.  See also realized gain or loss,
unrealized gain or loss.
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foreign currency journal entry  A journal
entry in which you record transactions in a
foreign currency.  Oracle Order Entry
automatically converts foreign currency
amounts into your functional currency
using an exchange rate you specify.  See
also foreign currency, functional currency.

foreign currency revaluation  A process that
allows you to revalue assets and liabilities
denominated in a foreign currency using a
period–end (usually a balance sheet date)
exchange rate.  Oracle Order Entry
automatically revalues your foreign assets
and liabilities using the period–end
exchange rate you specify.  Revaluation
gains and losses result from fluctuations in
an exchange rate between a transaction
date and a balance sheet date.   Oracle
Order Entry automatically creates a journal
entry in accordance with FASB 52 (U.S.) to
adjust your unrealized gain/loss account
when you run revaluation.

foreign currency translation  A process that
allows you to restate your functional
currency account balances into a reporting
currency.  Oracle Order Entry multiplies the
average, periodic, or historical rate you
define by your functional currency account
balances to perform foreign currency
translation.  Oracle Order Entry translates
foreign currency in accordance with FASB
52  (U.S.).  Oracle Order Entry also
remeasures foreign currencies for
companies in highly inflationary
economies, in accordance with FASB 8
(U.S.).

formula entry  A recurring journal entry that
uses formulas to calculate journal entry
lines.  Instead of specifying amounts, as
you would for a standard entry, you use
formulas, and Oracle Order Entry
calculates the amounts for you.  For
example, you might use recurring journal
entries to do complex allocations or
accruals that are computed using statistics
or multiple accounts.

function security  An Oracle Applications
feature that lets you control user access to
certain functions and windows.  By default,
access to functionality is not restricted; your
system administrator customizes each
responsibility at your site by including or
excluding functions and menus in the
Responsibilities window.

functional currency The principal currency
you use to record transactions and maintain
accounting data within Oracle Order Entry.
The functional currency is usually the
currency in which you perform most of
your business transactions.  You specify the
functional currency for each set of books in
the Set of Books window. 

funding budget  A budget against which
accounting transactions are checked for
available funds when budgetary control is
enabled for your set of books.



Glossary – 12 Oracle Applications Desktop Integrator Tutorial

funds available  The difference between the
amount you are authorized to spend and
the amount of your expenditures plus
commitments.  You can track funds
availability at different authority levels
using the Online Funds Available inquiry
window, or you can create custom reports
with the Oracle Order Entry Financial
Statement Generator.

funds checking  The process of certifying
funds available.  You can check funds when
you enter actual, budget, or encumbrance
journals.When you check funds, Oracle
Applications compares the amount of your
transaction against your funds available
and notifies you online whether funds are
available for your transaction.  Oracle
Applications does not reserve funds for
your transaction when you check funds.

funds reservation   The process of reserving
funds available.  You can reserve funds
when you enter actual, budget, or
encumbrance journals.  When you reserve
funds, Oracle Applications compares the
amount of your transaction against your
funds available and notifies you online
whether funds are available for your
transaction. 

historical exchange rate  A weighted–average
rate for transactions that occur at different
times.  Oracle Order Entry uses historical
rates to translate owner’s equity accounts
in accordance with FASB 52 (U.S.).  For
companies in highly inflationary
economies, Oracle Order Entry uses
historical rates to remeasure specific
historical account balances, according to
FASB 8.

HP Notation  Mathematical logic upon which
EasyCalc is based.  HP Notation is used by
Hewlett–Packard calculators.  HP Notation
emphasizes straightforward, logical entry
of data, and de–emphasizes complicated
parenthetical arrangements of data.

import  A utility that enables you to bring data
from an export file into an Oracle7 table.
The import utility is part of the Oracle7
Relational Database Management System.
This utility is used to restore archived data.

import journal entry  A journal entry from a
non–Oracle application, such as accounts
payable, accounts receivable, and fixed
assets.  You use Journal Import to import
these journal entries from your feeder
systems.

integer data type  Any Oracle Financial
Analyzer variables with an integer data
type containing whole numbers with values
between –2.14 billion and +2.14 billion.

intercompany journal entry  A journal entry
that records transactions between affiliates.
General Ledger keeps your accounting
records in balance for each company by
automatically creating offsetting entries to
an intercompany account you define.

Item Validation Organization  The
organization that contains your master list
of items.  You define this organization by
setting the OE: Item Validation
Organization profile option.  See also
organization.
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journal details tables  Journal details are
stored in the database tables
GL_JE_BATCHES, GL_JE_HEADERS, and
GL_JE_LINES.

journal entry  A debit or credit to a general
ledger account.  See also manual journal
entry.

journal entry category  A category in which
Oracle Order Entry describes the purpose
or type of journal entry.  Standard journal
entry categories include accruals,
payments, and vouchers. 

journal entry source  The source by which
Oracle Order Entry identifies and
differentiates the origin of  journal entries.
Standard journal entry sources include
payables, payroll, personnel, and
receivables. 

Journal Import  A General Ledger program
that creates journal entries from transaction
data stored in the General Ledger
GL_INTERFACE table.  Journal entries are
created and stored in GL_JE_BATCHES,
GL_JE_HEADERS, and GL_JE_LINES.

jurisdiction code  An abbreviated address that
is specific to a Tax Supplier and more
accurate than a simple five digit zip code.

key flexfield  An Oracle Applications feature
you use to build custom fields in which you
can enter and display information relating
to your business.  The General Ledger
Accounting Flexfield is a key flexfield.

lamp  A one–word message that Oracle
Applications displays in the message line of
any window to notify you that a particular
feature is available for a particular field. 

manual journal entry  A journal entry you
enter at a computer terminal.  Manual
journal entries can include regular,
statistical, intercompany and foreign
currency entries. 

Many–to–Many attribute  In Oracle Financial
Analyzer, a relationship between one or
more values of one base dimension with
one or more values of a second base
dimension.  For example, if you have a
Many–to–Many attribute definition where
the first base dimension is Organization
and the second base dimension is Line
Item, then a single organization can be
related to several line items, and a single
line item can be related to several
organizations.

MassAllocations  A single journal entry
formula that allocates revenues and
expenses across a group of cost centers,
departments, divisions, and so on.  For
example, you might want to allocate your
employee benefit costs to each of your
departments based on headcount in each
department.

MassBudgeting  A feature that allows you to
build a complete budget using simple
formulas based on actual results, other
budget amounts, and statistics.  For
example, you may want to draft next year’s
budget using last year’s actual results plus
10 percent or some other growth factor.
With MassBudgeting, you can apply one
rule to a range of accounts.

master budget  A budget that controls the
authority of other budgets.
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message distribution   A line at the bottom of
the toolbar that displays helpful hints,
warning messages, and basic data entry
errors.  

message line  A line on the bottom of a
window that displays helpful hints or
warning messages when you encounter an
error.

meta data  Data you enter in Oracle General
Ledger to represent structures in Oracle
Financial Analyzer.  Meta data consists of
the dimensions, segment range sets,
hierarchies, financial data items, and
financial data sets you define in Oracle
General Ledger.  When you load financial
data from Oracle General Ledger, Oracle
Financial Analyzer creates dimensions,
dimension values, hierarchies, and
variables based on the meta data.

model  A set of interrelated equations for
calculating data in Oracle Financial
Analyzer.

multi–org  See multiple organizations.

multiple organizations  The ability to define
multiple organizations and the
relationships among them within a single
installation of Oracle Applications.  These
organizations can be sets of books, business
groups, legal entities, operating units, or
inventory organizations.

Multiple Reporting Currencies  An Oracle
General Ledger feature that allows you to
report in your functional currency and in
one or more foreign currencies.

natural account segment  In Oracle General
Ledger, the segment that determines
whether an account is an asset, liability,
owners’ equity, revenue, or expense
account.  When you define your chart of
accounts, you must define one segment as
the natural account segment.  Each value
for this segment is assigned one of the five
account types.

nesting  The act of grouping calculations to
express the sequence of routines in a
formula.  Traditional mathematical nesting
uses parenthesis and brackets.  Oracle
Order Entry EasyCalc uses a
straightforward and logical nesting method
that eliminates the need for parenthetical
expressions.

net allocation  Allocation in which you post
the net of all allocations to an allocated–out
account.

obligation  An encumbrance you record when
you turn a requisition into a purchase
order.

One–to–Many attribute  A relationship in
Oracle Financial Analyzer where one or
more values of a base dimension are related
to a single value of an aggregate dimension.
For example, if you have a One–to–Many
attribute definition where the base
dimension is Organization and the
aggregate dimension is Level, each
organization can be related to only a single
level.
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operator  A mathematical symbol you use to
indicate the mathematical operation in your
calculation.

organization  A business unit such as a
company, division, or department.
Organization can refer to a complete
company, or to divisions within a company.
Typically, you define an organization or a
similar term as part of your account when
you implement Oracle Financials.  See also
business group.  

parameter   See report parameter.

parent segment value  An account segment
value that references a number of other
segment values, called child segment
values.  Oracle Order Entry uses parent
segment values for creating summary
accounts, for reporting on summary
balances, and in MassAllocations and
MassBudgeting.  You can create parent
segment values for independent segments,
but not for dependent segments. Oracle
Financial Analyzer uses parent and child
segment values to create hierarchies.  See
also child segment value.

period type  You use accounting period types
to define your accounting calendar.

period–average exchange rate  See average
exchange rate.

period average–to–date  The average of the
end–of–day balances for a related range of
days within a period.

period–end exchange rate  The daily exchange
rate on the last day of an accounting period.
Oracle Order Entry automatically translates
asset and liability account balances using
period–end rates, in accordance with FASB
52 (U.S.).  When you run revaluation for a
period, Oracle Order Entry automatically
uses the inverse of your period–end rate to
revalue your foreign currency denominated
assets and liabilities in accordance with
FASB 52 (U.S.).  For companies in highly
inflationary economies, Oracle Order Entry
uses period–end rates to remeasure the
balances of asset and liability accounts
according to FASB 8 (U.S.).

personal library  If an Oracle Financial
Analyzer database object belongs to a
personal library, it means that the object
was created by the workstation user and
can be modified.

planned purchase order  A type of purchase
order you issue before you order delivery
of goods and services for specific dates and
locations.  You usually enter a planned
purchase order to specify items you want to
order and when you want the items
delivered.  You later enter a shipment
release against the planned purchase order
to order the items.

pop–up window  An additional window that
appears on an Oracle Applications form
when your cursor enters a particular field.

posting date  The date a journal transaction is
actually posted to the general ledger.

profile option  A set of changeable options
that affect the way your applications run.
In general, profile options can be set at one
or more of the following levels:  site,
application, responsibility, and user.  Refer
to the Profile Option appendix in the Oracle
General Ledger User’s Guide for more
information.
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project segment  To set up your account, you
define the individual segments of your
general ledger account code.  You can
define a project segment to enter your
project identifier.  You define all key
attributes of the segment, including field
length, position of the segment within your
account, prompt, type of characters
(numeric or alphanumeric), and default
value (optional).

project segment value  The identifier (project
name, number, or code) you use to
designate each project.  After you define a
project segment in your account, you set up
a project in Oracle Order Entry by simply
defining a project segment value.  For
example, you could define a project name
(ALPHA), a project number (583), or a
project code (D890).

proprietary account  An account segment
value (such as 3500) assigned one of the
five proprietary account types.  The five
types include Asset, Liability, Owner’s
Equity, Revenue, and Expense.

Proprietary account  An account that contains
a proprietary account.

proprietary account type  Any of the five
account types: Asset, Liability, Owner’s
Equity, Revenue, and Expense.

proprietary funds  A fund type that uses
accounting and reporting techniques
similar to commercial enterprises.
Examples of proprietary funds include
internal service funds, such as a central
motor pool or central public works facility,
and enterprise funds.

purchase order (PO)  A document used to buy
and  request delivery of goods or services
from a supplier. 

purchase order encumbrance  A transaction
representing a legally binding purchase.
Oracle Purchasing subtracts purchase order
encumbrances from funds available when
you approve a purchase order.  If you
cancel a purchase order, Oracle Purchasing
creates appropriate reversing
encumbrances entries in your general
ledger.  Also known as obligation,
encumbrance or lien.

quarter average–to–date  The average of the
end–of–day balances for a related range of
days within a quarter.

query  A search for applications information
that you initiate using an Oracle
Applications window.

realized gain or loss  The actual gain or loss in
value that results from holding an asset or
liability over time.  Realized gains and
losses are shown separately on the Income
Statement.  See also unrealized gain or loss,
foreign currency exchange gain or loss.

recurring formula  See recurring journal entry.

recurring journal entry  A journal entry you
define once; then, at your request, General
Ledger repeats the journal entry for you
each accounting period.  You use recurring
journal entries to define automatic
consolidating and eliminating entries.  Also
known as recurring formula.
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report  A combination of at least a row set and
column set, and optionally a content set,
display group, row order, and runtime
options, such as currency and override
segment name, that you can define and
name.  When you request financial
statements, you can enter this name, and
Oracle Order Entry automatically enters the
report components and runtime options for
you.  You simply specify the accounting
period.  Oracle Order Entry automatically
enters the rest.

report component  An element of a Financial
Statement Generator report that defines the
format and content of your report.  Report
components include row sets, column sets,
content sets, row orders, and display sets.
You can group report components together
in different ways to create custom reports.

report headings  A descriptive section found
at the top of each report giving general
information about the contents of the
report. 

report option  See report parameter.

report parameter  Options that let you sort,
format, select, and summarize the
information in your reports.  

report set  A group of reports that you submit
at the same time to run as one transaction.
A report set allows you to submit the same
set of reports regularly without having to
specify each report individually.  For
example, you can define a report set that
prints all of your regular month–end
management reports.

reporting currency  The currency you use for
financial reporting.  If your reporting
currency is not the same as your functional
currency, you can use foreign currency
translation to restate your account balances
in your reporting currency.

reporting hierarchies  Summary relationships
within an account segment that let you
group detailed values of that segment to
prepare summary reports.  You define
summary (parent) values that reference the
detailed (children) values of that segment.

requisition encumbrance  A transaction
representing an intent to purchase goods
and services as indicated by the completion
and approval of a requisition.  Oracle
Purchasing subtracts requisition
encumbrances from funds available when
you reserve funds for a requisition.  If you
cancel a requisition,  Oracle Purchasing
creates appropriate reversing entries in
your general ledger.  Also known as
commitment, pre–encumbrance or
pre–lien.

Reserve for Encumbrance  A portion of fund
balance you use to record anticipated
expenditures.  In Oracle Applications, you
define your Reserve for Encumbrance
account when you define your set of books.
Oracle Applications uses your Reserve for
Encumbrance account to create offsets for
unbalanced encumbrance entries you create
in Oracle Purchasing, Oracle Payables, and
General Ledger.
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Reserve for Encumbrance account  The
account you use to record your
encumbrance liability.  You define a Reserve
for Encumbrance account when you define
your set of books.  When you create
encumbrances automatically in Oracle
Purchasing or Oracle Order Entry, General
Ledger automatically creates a balancing
entry to your Reserve for Encumbrance
account as you post your encumbrance
journal entries.  General Ledger overwrites
the balancing segment for your Reserve for
Encumbrance account, so you
automatically create the reserve for
encumbrance journal entry to the correct
company.

responsibility   A level of authority within
Oracle Order Entry.  Each responsibility
provides a user with access to a menu and a
set of books.  You can assign one or more
responsibilities to each user.
Responsibilities let you control security in
Oracle Order Entry. 

responsibility report  A financial statement
containing information organized by
management responsibility.  For example, a
responsibility report for a cost center
contains information for that specific cost
center, a responsibility report for a division
manager contains information for all
organizational units within that division,
and so on.  A manager typically receives
reports for the organizational unit(s) (such
as cost center, department, division, group,
and so on) for which he or she is
responsible.

revaluation  See foreign currency revaluation. 

revaluation gain/loss account  An income
statement account you specify in which
Oracle Order Entry records net revaluation
gains and losses, in accordance with FASB
52 (U.S.).  You specify the account you want
to use for unrealized revaluation gains and
losses in the Run Revaluation window.  You
can change your revaluation gain/loss
account as often as you want.  When you
run revaluation, Oracle Order Entry creates
a batch of revaluation journal entries that
adjust your revaluation gain/loss account.
Oracle Order Entry also marks the journal
entries for reversal in the next accounting
period.

revaluation journal entry  A journal entry that
is automatically created when you run
revaluation for a range of accounts
denominated in a foreign currency.  Oracle
Order Entry creates a batch of revaluation
journal entries when the exchange rate used
for conversion on your transaction date
differs from the exchange rate on your
balance sheet date.  Oracle Order Entry
creates a journal entry to adjust an income
statement gain and loss account for
exchange rate fluctuations, in accordance
with FASB 52 (U.S.).
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revaluation status report  A report that
summarizes the results of your revaluation.
Oracle Order Entry automatically generates
this report whenever you revalue foreign
asset and liability account balances for an
accounting period in your calendar.  You
can review this report to identify accounts
that were revalued in Oracle Order Entry
and journal batches and entries that were
created because of the revaluation.

reversing journal entry  A journal entry
General Ledger creates by reversing an
existing journal entry.  You can reverse any
journal entry and post it to any open
accounting period.

rollup group  A collection of parent segment
values for a given segment.  You use rollup
groups to define summary accounts based
on parents in the group.  You can use letters
as well as numbers to name your rollup
groups.

root node  A parent segment value in Oracle
General Ledger that is the topmost node of
a hierarchy.  When you define a hierarchy
using the Hierarchy window, you specify a
root node for each segment.  Oracle
Financial Analyzer creates a hierarchy by
starting at the root node and drilling down
through all of the parent and child segment
values.  See also parent segment value.

row order  A report component that you use to
modify the order of detail rows and
account segments in your report.  You can
rank your rows in ascending or descending
order based on the amounts in a particular
column and/or by sorting your account
segments either by segment value or
segment value description.  You also
specify display options, depending on the
row ranking method you choose.  For
example, if you want to review Total Sales
in descending order by product, you can
rank your rows in descending order by the
Total Sales column and rearrange your
segments so that product appears first on
your report. 

row set  A Financial Statement Generator
report component that you build within
Oracle Order Entry by defining all of the
lines in your report.  For each row, you
control the format and content, including
line descriptions, indentations, spacing,
page breaks, calculations, units of measure,
precision and so on.  A typical row set
includes row labels, accounts and
calculation rows for totals.  For example,
you might define a standard income
statement row set or a standard balance
sheet row set.  

rule numbers  A sequential step in a
calculation.  You use rule numbers to
specify the order in which you want Oracle
Order Entry to process the factors you use
in your budget and actual formulas.

segments  The building blocks of your chart of
accounts in Oracle General Ledger.  Each
account is comprised of multiple segments.
Users choose which segments will make up
their accounts; commonly–used segments
include company, cost center, and product.



Glossary – 20 Oracle Applications Desktop Integrator Tutorial

segment values  The possible values for each
segment of the account.  For example, the
Cost Center segment could have the values
100, which might represent Finance, and
200, which might represent Marketing.

selection tools  A set of tools in Oracle
Financial Analyzer that provide shortcut
methods for selecting the values that you
want to work with in a report, graph, or
worksheet.

sales tax  A tax collected by a tax authority on
purchases of goods and services.  The
supplier of the good or service collects sales
taxes from its customers (tax is usually
included in the invoice amount) and remits
them to a tax authority.  Tax is usually
charged as a percentage of the price of the
good or service.  The percentage rate
usually varies by authority and sometimes
by category of product.  Sales taxes are
expenses to the buyer of goods and
services.

sales tax structure  The collection of taxing
bodies that you will use to determine your
tax authority.  ’State.County.City’ is an
example of a Sales Tax Structure.  Oracle
Order Entry adds together the tax rates for
all of these components to determine a
customer’s total tax liability for a
transaction.

set of books  A financial reporting entity that
uses a particular chart of accounts,
functional currency and accounting
calendar.  You must define at least one set
of books for each business location.

SFAS 52 (U.S.)  Statement of Financial
Accounting Standards number 52, issued
by the Financial Accounting Standards
Board (FASB), which dictates accounting
and reporting standards for translating
foreign currency transactions in the United
States.  Oracle Order Entry translates and
revaluates such transactions according to
SFAS 52 (U.S.) standards.  Usually, SFAS 52
(U.S.) mandates the use of a period–end
exchange rate to translate asset and liability
accounts, and an average exchange rate to
translate revenue and expense accounts.
Foreign currency denominated assets and
liabilities are revalued using a period–end
rate on each balance sheet date, to reflect
the period–end exchange rate in accordance
with SFAS 52 (U.S.).  You specify the
account used for revaluation gains and
losses in the Run Revaluation window.  You
maintain the rates used for translation and
revaluation in the Define Period Rates and
Define Historical Rates forms.  SFAS 52
(U.S.) also mandates that you post any
out–of–balance amounts arising from
translation to a Cumulative Translation
Adjustment account included in
stockholders equity.  You define the
Cumulative Translation Adjustment
account in the Set of Books window.
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SFAS 8 (U.S.)  Statement of Financial
Accounting Standards number 8, issued by
the Financial Accounting Standards Board
(FASB), which mandates that you use a
historical exchange rate for all accounts
based on past purchase exchanges, and that
you use a current exchange rate for all
accounts based on current purchase,
current sale, and future exchanges.  Oracle
Order Entry remeasures specific account
balances using historical rates you specify
for companies in highly inflationary
economies according to the standards of
SFAS 8 (U.S.).  SFAS 8 (U.S.) also mandates
that you record any out–of–balance
amounts arising from translation to an
income/expense account included in your
income statement.

shortdecimal data type  Oracle Financial
Analyzer variables with a shortdecimal
data type contain decimal numbers with up
to 7 significant digits.

shortinteger data type  Oracle Financial
Analyzer variables with a shortinteger data
type contain whole numbers with values
between –32768 and +32768.

shorthand flexfield entry  A quick way to
enter key flexfield data using shorthand
aliases (names) that represent valid flexfield
combinations or patterns of valid segment
values.  Your organization can specify
flexfields that will use shorthand flexfield
entry and define shorthand aliases for these
flexfields that represent complete or partial
sets of key flexfield segment values.

skeleton entry  A recurring journal entry the
amounts of which change each accounting
period.  You simply define a recurring
journal entry without amounts, then enter
the appropriate amounts each accounting
period.  For example, you might define a
skeleton entry to record depreciation in the
same accounts every month, but with
different amounts due to additions and
retirements.

spot exchange rate  A daily exchange rate you
use to perform foreign currency
conversions.  The spot exchange rate is
usually a quoted market rate that applies to
the immediate delivery of one currency for
another.

spreadsheet interface  A program that
uploads your actual or budget data from a
spreadsheet into Oracle Order Entry.

standard balance  The usual and customary
period–to–date, quarter–to–date, or
year–to–date balance for an account.  The
standard balance is the sum of an account’s
opening balance, plus all activity for a
specified period, quarter, or year.  Unlike
an average balance, no additional
computations are needed to arrive at the
standard balance.

standard entry  A recurring journal entry
whose amount is the same each accounting
period.  For example, you might define a
standard entry for fixed accruals, such as
rent, interest, and audit fees.
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Standard Request Submission  A standard
interface in Oracle Applications in which
you run and monitor your application’s
reports and other processes.

STAT  The statistical currency Oracle General
Ledger uses for maintaining statistical
balances.  If you enter a statistical
transaction using the STAT currency, Oracle
General Ledger will not convert your
transaction amounts.

statistical journal entry  A journal entry in
which you enter nonfinancial information
such as headcount, production units, and
sales units.

statistics  Accounting information (other than
currency amounts) you use to manage your
business operations.  With Oracle Order
Entry, you can maintain budget and actual
statistics and use these statistics with
budget rules and formulas.

status line  A status line appearing below the
message line of a root window that displays
status information about the current
window or field.  A status line can contain
the following:  ^ or v symbols indicate
previous records before or additional
records following the current record in the
current block; Enter Query indicates that
the current block is in Enter Query mode,
so you can specify search criteria for a
query; Count indicates how many records
were retrieved or displayed by a query (this
number increases with each new record you
access but does not decrease when you
return to a prior record); the <Insert>
indicator or lamp informs you that the
current window is in insert character mode;
and the <List> lamp appears when a list of
values is available for the current field.

step–down allocation  An allocation upon
which you run another allocation.  For
example, you might allocate parent
company overhead to operating companies
based on revenues.  You can then use a
step–down allocation to allocate overhead
to cost centers within the operating
companies based on headcount. 

summary account  An account whose balance
represents the sum of other account
balances.  You can use summary accounts
for faster reporting and inquiry as well as
in formulas and allocations.

tablespace  The area in which an Oracle
database is divided to hold tables.

tax authority   A governmental entity that
collects taxes on goods and services
purchased by a customer from a supplier.
In some countries, there are many
authorities (e.g. state, local and federal
governments in the US), while in others
there may be only one.  Each authority may
charge a different tax rate.  Within Oracle
Order Entry, tax authority consists of all
components of your tax structure.  For
example:  California.San Mateo.Redwood
Shores for State.County.City.  Oracle Order
Entry adds together the tax rates for all of
these locations to determine a customer’s
total tax liability for an invoice.

tax codes  Codes to which you assign sales tax
or value–added tax rates.  Oracle
Receivables lets you choose state codes as
the tax code when you define sales tax rates
for the United States.  (Receivables
QuickCode)
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tax engine  A collection of programs, user
defined system parameters, and
hierarchical flows used by Oracle Order
Entry to calculate tax.

tax exempt  A customer, business purpose, or
item to which tax charges do not apply.  

Tax Identification Number  In the United
States, the number used to identify 1099
suppliers.  If a 1099 supplier is an
individual, the Tax Identification Number is
the supplier’s social security number.  If a
1099 supplier is a corporation, the Tax
Identification Number is also known as the
Federal Identification Number.  

tax location  A specific tax location within
your tax authority.  For example ’Redwood
Shores’ is a tax location in the Tax
Authority California.San Mateo.Redwood
Shores.

tax type  A feature you use to indicate the type
of tax charged by a tax authority when you
define a tax name.  Oracle Order Entry uses
the tax type during invoice entry to
determine the financial impact of the tax.
When you enter a tax of type Sales, Oracle
Order Entry creates a separate invoice
distribution line for the tax amount.  When
you enter a tax of type Use, Oracle Order
Entry does not create the invoice
distribution line.

template  A pattern that Oracle Order Entry
uses to create and maintain summary
accounts.  For each template you specify,
Oracle Order Entry automatically creates
the appropriate summary accounts.

Time dimension  An Oracle Financial
Analyzer dimension whose values
represent time periods.  A time period can
be a month, quarter, or year.  The length of
the Time dimension’s values is determined
by the Width option on the Maintain
Dimension window.

translation  See revaluation. foreign currency
translation.

unrealized gain or loss  The measured change
in value of an asset or liability over time.
Oracle Payables provides a report (the
Unrealized Gain and Loss Report) that you
can submit from the standard report
submission form at any time to review your
unrealized gains and losses.  See also
realized gain or loss.

use tax  A tax that you pay directly to a tax
authority instead of to the supplier.
Suppliers do not include use tax on their
invoices.  You sometimes owe use tax for
goods or services you purchased outside of,
but consumed (used) within the territory of
a tax authority.  Use taxes are liabilities to
the buyer of goods and services.  You can
define a tax name for use taxes.  When you
enter a use tax name on an invoice, Oracle
Order Entry does not create an invoice
distribution or general ledger journal entry
for the tax.

user profile   See profile option.

value  Data you enter in a parameter.  A value
can be a date, a name, or a code, depending
on the parameter.
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value set  A group of values and related
attributes you assign to an account segment
or to a descriptive flexfield segment.
Values in each value set have the same
maximum length, validation type,
alphanumeric option, and so on.

value added tax (VAT)  A tax on the supply of
goods and services paid for by the
consumer, but collected at each stage of the
production and distribution chain.  The
collection and payment of value added tax
amounts is usually reported to tax
authorities on a quarterly basis and is not
included in the revenue or expense of a
company.  With Oracle Order Entry, you
control the tax names on which you report
and the reference information you want to
record.  You can also request
period–to–date value added tax reports.

variable  An Oracle Financial Analyzer
database object that holds raw data.  Data
can be numerical, such as sales or expense
data, or textual, such as descriptive labels
for products.

variable text  Variable text is used when dialog
boxes or their components are unlabeled or
have labels that change dynamically based
on their current context.  The wording of
variable text does not exactly match what
you see on your screen.

voucher number  A number used as a record
of a business transaction.  A voucher
number may be used to review invoice
information, in which case it serves as a
unique reference to a single invoice.

weighted–average exchange rate  An
exchange rate that Oracle Order Entry
automatically calculates by multiplying
journal amounts for an account by the
translation rate that applies to each journal
amount.  You choose whether the rate that
applies to each journal amount is based on
the inverse of the daily conversation rate or
on an exception rate  you enter manually.
Oracle Order Entry uses the
weighted–average rate, instead of the
period–end, average, or historical rates, to
translate balances for accounts assigned a
weighted–average rate type.

year average–to–date  The average of the
end–of–day balances for a related range of
days within a year.

Zoom  A forms feature that is obsolete in GUI
versions of Oracle Applications.
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